User Guide
Conventions used in this guide

💡 **TIP:** Tips provide helpful hints or shortcuts.

🔍 **NOTE:** Notes provide important information to explain a concept or to complete a task.

⚠️ **CAUTION:** Cautions indicate procedures that you should follow to avoid losing data or damaging the product.

⚠️ **WARNING!** Warnings alert you to specific procedures that you should follow to avoid personal injury, catastrophic loss of data, or extensive damage to the product.
# Table of contents

## 1 Product basics ................................................................. 1
- Product comparison ......................................................... 2
- Environmental features .................................................... 4
- Accessibility features ...................................................... 4
- Product views ................................................................. 5
  - Front view ................................................................. 5
  - Back view .......................................................................... 6
- Interface connections ....................................................... 6
- Serial number and model number location .................... 7
- Control panel layout ....................................................... 8

## 2 Control panel menus .......................................................... 9
- HP Web Services menu .................................................... 10
- Reports menu ................................................................... 10
- Quick Forms menu ......................................................... 11
- System Setup menu ......................................................... 12
- Service menu ................................................................... 17
- Network Setup menu ..................................................... 18

## 3 Software for Windows ......................................................... 19
- Supported operating systems and printer drivers for Windows ..................................................... 20
- Select the correct printer driver for Windows ................................................................. 20
  - HP Universal Print Driver (UPD) .................................................. 22
    - UPD installation modes .................................................. 22
- Change print job settings for Windows ......................................................... 23
  - Priority for print settings .................................................. 23
  - Change the settings for all print jobs until the software program is closed .................. 23
  - Change the default settings for all print jobs .......................................... 23
  - Change the product configuration settings ........................................ 24
- Remove the printer driver from Windows ..................................................... 25
- Supported utilities for Windows ............................................... 25
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other Windows components and utilities</td>
<td>26</td>
</tr>
<tr>
<td>Software for other operating systems</td>
<td>26</td>
</tr>
<tr>
<td>4 Use the product with Mac</td>
<td>27</td>
</tr>
<tr>
<td>Software for Mac</td>
<td>28</td>
</tr>
<tr>
<td>Supported operating systems and printer drivers for Mac</td>
<td>28</td>
</tr>
<tr>
<td>Install software for Mac operating systems</td>
<td>28</td>
</tr>
<tr>
<td>Install software for Mac computers connected directly to the product</td>
<td>28</td>
</tr>
<tr>
<td>Install software for Mac computers on a wired network</td>
<td>29</td>
</tr>
<tr>
<td>Configure the IP address</td>
<td>29</td>
</tr>
<tr>
<td>Install the software</td>
<td>29</td>
</tr>
<tr>
<td>Install software for Mac computers on a wireless network</td>
<td>29</td>
</tr>
<tr>
<td>Connect the product to a wireless network using WPS by using the control panel menus</td>
<td>30</td>
</tr>
<tr>
<td>Connect the product to a wireless network using a USB cable</td>
<td>30</td>
</tr>
<tr>
<td>Remove the printer driver from Mac operating systems</td>
<td>31</td>
</tr>
<tr>
<td>Priority for print settings for Mac</td>
<td>31</td>
</tr>
<tr>
<td>Change printer-driver settings for Mac</td>
<td>31</td>
</tr>
<tr>
<td>Change the settings for all print jobs until the software program is closed</td>
<td>31</td>
</tr>
<tr>
<td>Change the default settings for all print jobs</td>
<td>31</td>
</tr>
<tr>
<td>Change the product configuration settings</td>
<td>32</td>
</tr>
<tr>
<td>Software for Mac computers</td>
<td>32</td>
</tr>
<tr>
<td>HP Utility for Mac</td>
<td>32</td>
</tr>
<tr>
<td>Open the HP Utility</td>
<td>32</td>
</tr>
<tr>
<td>HP Utility features</td>
<td>32</td>
</tr>
<tr>
<td>Supported utilities for Mac</td>
<td>33</td>
</tr>
<tr>
<td>HP Embedded Web Server</td>
<td>33</td>
</tr>
<tr>
<td>HP ePrint</td>
<td>33</td>
</tr>
<tr>
<td>AirPrint</td>
<td>33</td>
</tr>
<tr>
<td>Basic print tasks with Mac</td>
<td>34</td>
</tr>
<tr>
<td>Cancel a print job with Mac</td>
<td>34</td>
</tr>
<tr>
<td>Change the paper size and type with Mac</td>
<td>34</td>
</tr>
<tr>
<td>Resize documents or print on a custom paper size with Mac</td>
<td>34</td>
</tr>
<tr>
<td>Create and use printing presets with Mac</td>
<td>34</td>
</tr>
<tr>
<td>Print a cover page with Mac</td>
<td>35</td>
</tr>
<tr>
<td>Use watermarks with Mac</td>
<td>35</td>
</tr>
<tr>
<td>Print multiple pages on one sheet of paper with Mac</td>
<td>36</td>
</tr>
<tr>
<td>Print on both sides of the page (duplex printing) with Mac</td>
<td>36</td>
</tr>
<tr>
<td>Set the color options with Mac</td>
<td>37</td>
</tr>
<tr>
<td>Use AirPrint</td>
<td>38</td>
</tr>
<tr>
<td>Solve problems with Mac</td>
<td>39</td>
</tr>
</tbody>
</table>
Manage print cartridges ...................................................................................................................... 66
  Change settings for print cartridges ................................................................................................. 66
    Print when a print cartridge is at estimated end of life ................................................................. 66
    Enable or disable the At Very Low settings from the control panel .............................................. 66
    Print with EconoMode .................................................................................................................... 67
  Store and recycle supplies ................................................................................................................. 67
    Recycle supplies .............................................................................................................................. 67
    Print-cartridge storage ..................................................................................................................... 67
    HP policy on non-HP print cartridges ........................................................................................... 67
  HP anticounterfeit Web site .............................................................................................................. 68
Replacement instructions ........................................................................................................................ 69
  Replace the print cartridges ............................................................................................................... 69
Solve problems with supplies .............................................................................................................. 73
  Check the print cartridges ................................................................................................................ 73
    Print the Supplies Status page ....................................................................................................... 74
    Interpret the Print Quality Page ..................................................................................................... 75
    Inspect the print cartridge for damage .......................................................................................... 75
    Repeating defects ........................................................................................................................... 76
  Interpret control panel messages for supplies .................................................................................. 77
    10.XXXX Supply error ..................................................................................................................... 77
    Black cartridge low ......................................................................................................................... 77
    Black in wrong position ................................................................................................................... 77
    Black very low ............................................................................................................................... 78
    Cyan cartridge low ........................................................................................................................ 78
    Cyan in wrong position .................................................................................................................... 78
    Cyan very low .................................................................................................................................. 78
    Genuine HP supply installed ........................................................................................................... 79
    Incompatible <color> ...................................................................................................................... 79
    Incorrect supplies ........................................................................................................................... 79
    Install <color> cartridge .................................................................................................................. 79
    Magenta cartridge low .................................................................................................................... 79
    Magenta in wrong position .............................................................................................................. 80
    Magenta very low ........................................................................................................................... 80
    Remove shipping lock from <color> cartridge ............................................................................... 80
    Remove shipping locks from cartridges .......................................................................................... 80
    Replace <color> cartridge ................................................................................................................ 81
    Supplies low ........................................................................................................................................ 81
    Unsupported <color> Press [OK] to continue .................................................................................... 81
    Used <color> in use ........................................................................................................................... 81
    Used <color> installed Press [OK] to continue .................................................................................. 82
    Used supplies in use ........................................................................................................................ 82
8 Print tasks .................................................................................................................................................. 85
  Cancel a print job ................................................................................................................................................. 86
  Basic print tasks with Windows ......................................................................................................................... 87
    Open the printer driver with Windows ............................................................................................................... 87
    Get help for any printing option with Windows ................................................................................................. 88
    Change the number of print copies with Windows ................................................................................................. 88
    Save custom print settings for reuse with Windows ............................................................................................. 88
      Use a printing shortcut with Windows ............................................................................................................... 88
      Create printing shortcuts ....................................................................................................................................... 90
    Improve print quality with Windows .................................................................................................................... 92
      Select the page size with Windows ....................................................................................................................... 92
      Select a custom page size with Windows .............................................................................................................. 92
      Select the paper type with Windows ..................................................................................................................... 93
      Select the paper tray with Windows .................................................................................................................... 93
    Print on both sides (duplex) with Windows .......................................................................................................... 93
      Print on both sides manually with Windows ...................................................................................................... 93
      Automatically print on both sides with Windows ............................................................................................... 95
    Print multiple pages per sheet with Windows ..................................................................................................... 96
    Select page orientation with Windows ................................................................................................................ 98
    Set color options with Windows .......................................................................................................................... 100
  Use HP ePrint ...................................................................................................................................................... 101
  Additional print tasks with Windows .................................................................................................................... 102
    Print colored text as black (grayscale) with Windows ........................................................................................... 102
    Print on preprinted letterhead or forms with Windows ......................................................................................... 102
    Print on special paper, labels, or transparencies with Windows ........................................................................ 104
    Print the first or last page on different paper with Windows ................................................................................ 107
    Scale a document to fit page size with Windows ................................................................................................ 109
    Add a watermark to a document with Windows .................................................................................................. 111
    Create a booklet with Windows .......................................................................................................................... 111

9 Color ............................................................................................................................................................. 115
  Adjust color ......................................................................................................................................................... 116
  Change the color theme for a print job .................................................................................................................. 116
  Change the color options ....................................................................................................................................... 117
  Manual color options ............................................................................................................................................. 117
  Use the HP EasyColor option .................................................................................................................................. 119
  Match colors to your computer screen ................................................................................................................ 120
10 Manage and maintain

Print information pages ................................................................. 122
Use the HP Embedded Web Server .......................................................... 123
  Open the HP Embedded Web Server ....................................................... 123
  HP Embedded Web Server features ......................................................... 123
Use HP Web Jetadmin software ............................................................... 124
Product security features ............................................................... 124
  Assign a system password .......................................................................... 124
Economy settings ............................................................................. 125
  Print with EconoMode .............................................................................. 125
  Powersave modes ...................................................................................... 125
    Set sleep delay ........................................................................................ 125
    Set the Auto Power Down delay ............................................................... 125
Archive print ...................................................................................... 126
Install memory DIMMs ......................................................................... 127
  Install memory DIMMs ........................................................................... 127
  Enable memory .......................................................................................... 130
  Check DIMM installation .......................................................................... 131
  Memory allocation ..................................................................................... 131
Clean the product ........................................................................... 133
Product updates ................................................................................ 133

11 Solve problems

Self help ............................................................................................ 136
Solve general problems checklist ........................................................... 137
  Factors that affect product performance .................................................. 138
Restore factory settings ........................................................................ 139
Interpret control panel messages .......................................................... 140
  Control panel message types .................................................................. 140
  Control panel messages .......................................................................... 140
    10.XXXX Supply error ............................................................................ 140
    49 Error Turn off then on ....................................................................... 140
    50.X Fuser error Turn off then on .............................................................. 141
    51.XX Error Turn off then on .................................................................. 141
    54.XX Error Turn off then on ................................................................. 141
    55.X Error Turn off then on .................................................................... 142
    57 Fan error Turn off then on ................................................................. 142
    59.X Error Turn off then on .................................................................... 142
    79 Error Turn off then on ....................................................................... 142
    79 Service error Turn off then on ............................................................ 143
Paper feeds incorrectly or becomes jammed ................................................................. 153
  The product does not pick up paper ........................................................................ 153
  The product picks up multiple sheets of paper ....................................................... 153
  Prevent paper jams .................................................................................................. 153

Clear jams .................................................................................................................. 155
  Jam locations .......................................................................................................... 155
  Clear jams in Tray 1 ................................................................................................. 156
  Clear jams in Tray 2 ................................................................................................. 157
  Clear jams in the fuser area ..................................................................................... 158
  Clear jams in the output bin ................................................................................... 160
  Clear jams in the duplexer (duplexing models only) .............................................. 160

Improve print quality .................................................................................................. 163
  Use the correct paper type setting in the printer driver ............................................ 163
    Change the paper type setting for Windows .......................................................... 163
    Change the paper type setting for Mac ................................................................. 163
  Adjust color settings in the printer driver ............................................................... 164
    Change the color theme for a print job ................................................................. 164
    Change the color options .................................................................................... 165
  Use paper that meets HP specifications .................................................................. 165
  Print a cleaning page .............................................................................................. 166
  Calibrate the product to align the colors ................................................................. 166
  Check the print cartridges ...................................................................................... 167
    Print the Supplies Status page ............................................................................ 167
    Interpret the Print Quality Page .......................................................................... 168
    Inspect the print cartridge for damage ............................................................... 168
    Repeating defects ............................................................................................... 169
  Use the printer driver that best meets your printing needs ..................................... 169

The product does not print or it prints slowly ............................................................. 171
  The product does not print ...................................................................................... 171
  The product prints slowly ...................................................................................... 172

Solve product connectivity problems .......................................................................... 173
  Solve direct-connect problems .............................................................................. 173
  Solve network problems ...................................................................................... 173
    Poor physical connection .................................................................................... 173
    The computer is using the incorrect IP address for the product .......................... 173
    The computer is unable to communicate with the product ............................... 174
    The product is using incorrect link and duplex settings for the network ........... 174
    New software programs might be causing compatibility problems ................. 174
    The computer or workstation might be set up incorrectly .................................. 174
    The product is disabled, or other network settings are incorrect ....................... 174

Solve wireless network problems ............................................................................... 175
The control panel displays the message: The wireless feature on this product has been turned off.

The product does not print after the wireless configuration completes.

The product does not print, and the computer has a third-party firewall installed.

The wireless connection does not work after moving the wireless router or product.

Cannot connect more computers to the wireless product.

The wireless product loses communication when connected to a VPN.

The network does not appear in the wireless networks list.

The wireless network is not functioning.

Solve product software problems with Windows.

Solve product software problems with Mac.

The printer driver is not listed in the Print & Fax list.

The product name does not appear in the product list in the Print & Fax list.

The printer driver does not automatically set up the selected product in the Print & Fax list.

A print job was not sent to the product that you wanted.

When connected with a USB cable, the product does not appear in the Print & Fax list after the driver is selected.

You are using a generic printer driver when using a USB connection.

Appendix A  Supplies and accessories

Order parts, accessories, and supplies.

Part numbers.

Appendix B  Service and support

Hewlett-Packard limited warranty statement.

HP's Premium Protection Warranty: LaserJet print cartridge limited warranty statement.

Data stored on the print cartridge.

End User License Agreement.

OpenSSL.

Customer support.

Repack the product.

Appendix C  Product specifications

Physical specifications.

Power consumption, electrical specifications, and acoustic emissions.

Environmental specifications.

Appendix D  Regulatory information

FCC regulations.
1 Product basics

- Product comparison
- Environmental features
- Accessibility features
- Product views
Product comparison

<table>
<thead>
<tr>
<th>HP LaserJet Pro 300 color M351a CE955A</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance: Prints 18 pages per minute (ppm) on A4-size paper snf 19 ppm on Letter-size paper</td>
<td></td>
</tr>
<tr>
<td>Paper handling:</td>
<td></td>
</tr>
<tr>
<td>Tray 1 holds 50 sheets, Tray 2 holds 250 sheets</td>
<td></td>
</tr>
<tr>
<td>Optional Tray 3 holds 250 sheets</td>
<td></td>
</tr>
<tr>
<td>The output bin holds 150 sheets</td>
<td></td>
</tr>
<tr>
<td>Supported operating systems:</td>
<td></td>
</tr>
<tr>
<td>Windows XP, 32-bit</td>
<td></td>
</tr>
<tr>
<td>Windows Vista, 32-bit and 64-bit</td>
<td></td>
</tr>
<tr>
<td>Windows 7, 32-bit and 64-bit</td>
<td></td>
</tr>
<tr>
<td>Mac OS X v10.5 and later</td>
<td></td>
</tr>
<tr>
<td>Connectivity: Hi-Speed USB 2.0</td>
<td></td>
</tr>
<tr>
<td>Software installation: For Windows, use HP Smart Install for easy software installation.</td>
<td></td>
</tr>
<tr>
<td>Memory: 128 MB RAM, expandable to 384 MB</td>
<td></td>
</tr>
<tr>
<td>Control-panel display: 2-line text</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HP LaserJet Pro 400 color M451nw CE956A</th>
<th>Has the same features as the HP LaserJet Pro 300 color M351a model, with the following differences:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance: Prints 20 pages per minute (ppm) on A4-size paper and 21 ppm on Letter-size paper</td>
<td></td>
</tr>
<tr>
<td>Connectivity:</td>
<td></td>
</tr>
<tr>
<td>Hi-Speed USB 2.0</td>
<td></td>
</tr>
<tr>
<td>10/100 Ethernet LAN connection</td>
<td></td>
</tr>
<tr>
<td>Wireless network connection</td>
<td></td>
</tr>
</tbody>
</table>
HP LaserJet Pro 400 color M451dn
CE957A

Has the same features as the HP LaserJet Pro 300 color M351a model, with the following differences:

- Performance: Prints 20 pages per minute (ppm) on A4-size paper and 21 ppm on Letter-size paper
- Connectivity:
  - Hi-Speed USB 2.0
  - 10/100 Ethernet LAN connection
- Automatic duplex printing

HP LaserJet Pro 400 color M451dw
CE958A

Has the same features as the HP LaserJet Pro 300 color M351a model, with the following differences:

- Performance: Prints 20 pages per minute (ppm) on A4-size paper and 21 ppm on Letter-size paper
- Connectivity:
  - Hi-Speed USB 2.0
  - 10/100 Ethernet LAN connection
  - Wireless network connection
- Automatic duplex printing
Environmental features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplex printing</td>
<td>Save paper by using the manual duplex printing option. Automatic duplex printing is available with the HP LaserJet Pro 400 color M451dn and HP LaserJet Pro 400 color M451dw models.</td>
</tr>
<tr>
<td>Print multiple pages per sheet</td>
<td>Save paper by printing two or more pages of a document side-by-side on one sheet of paper. Access this feature through the printer driver.</td>
</tr>
<tr>
<td>Recycling</td>
<td>Reduce waste by using recycled paper.</td>
</tr>
<tr>
<td></td>
<td>Recycle print cartridges by using the HP Planet Partners return process.</td>
</tr>
<tr>
<td>Energy savings</td>
<td>Instant on Fusing technology and sleep mode enable this product to quickly go into reduced power states when not printing, thus saving energy.</td>
</tr>
</tbody>
</table>

Accessibility features

The product includes several features that aid users with accessibility issues.

- Online user guide that is compatible with text screen-readers.
- Print cartridges can be installed and removed by using one hand.
- All doors and covers can be opened by using one hand.
## Product views

### Front view

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Output bin</td>
</tr>
<tr>
<td>2</td>
<td>Legal-output extension</td>
</tr>
<tr>
<td>3</td>
<td>Front door (provides access to the print cartridges)</td>
</tr>
<tr>
<td>4</td>
<td>Tray 1 (multipurpose tray)</td>
</tr>
<tr>
<td>5</td>
<td>Tray 2 (provides jam access)</td>
</tr>
<tr>
<td>6</td>
<td>Optional Tray 3</td>
</tr>
<tr>
<td>7</td>
<td>Power button</td>
</tr>
<tr>
<td>8</td>
<td>Wireless button (wireless models only)</td>
</tr>
<tr>
<td>9</td>
<td>Control panel</td>
</tr>
<tr>
<td>10</td>
<td>DIMM door (for adding additional memory)</td>
</tr>
</tbody>
</table>
Back view

1 Hi-Speed USB 2.0 port and network port

NOTE: The network port is present on the M451nw, M451dn, and M451dw models only.

2 Power connection

3 Rear door (for jam access)

Interface connections

1 Network port (top)

2 USB port (bottom)
Serial number and model number location

The serial number and product model number label is on the inside of the front door.
Control panel layout

1 Control-panel display: The display provides information about the product. Use the menus on the display to establish product settings.

2 Back arrow button: Use this button for the following actions:
   - Exit the control-panel menus.
   - Scroll back to a previous menu in a submenu list.
   - Scroll back to a previous menu item in a submenu list (without saving changes to the menu item).

3 Left arrow button: Use this button to navigate through the menus or to decrease a value that appears on the display.

4 OK button: Press the OK button for the following actions:
   - Open the control-panel menus.
   - Open a submenu displayed on the control-panel display.
   - Select a menu item.
   - Clear some errors.
   - Begin a print job in response to a control-panel prompt (for example, when the message Press [OK] to continue appears on the control-panel display).

5 Right arrow button: Use this button to navigate through the menus or to increase a value that appears on the display.

6 Cancel button: Press this button to cancel a print job whenever the attention light is blinking or to exit the control-panel menus.

7 Ready light (green): The Ready light is on when the product is ready to print. It blinks when the product is receiving print data, or when the product is in sleep mode.

8 Attention light (amber): The Attention light blinks when the product requires user attention.
2 Control panel menus

- HP Web Services menu
- Reports menu
- Quick Forms menu
- System Setup menu
- Service menu
- Network Setup menu
## HP Web Services menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Address</td>
<td>Select whether to display the product’s e-mail address on the control panel when the ePrint feature is enabled.</td>
</tr>
<tr>
<td>Print Info Sheet</td>
<td>Print a page that contains the e-mail address for the product as well as other information for HP Web Services.</td>
</tr>
<tr>
<td>ePrint On/Off</td>
<td>Turn HP ePrint on or off.</td>
</tr>
<tr>
<td>Remove Services</td>
<td>Remove HP Web Services from this product.</td>
</tr>
</tbody>
</table>

## Reports menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Structure</td>
<td>Prints a map of the control panel-menu layout. The active settings for each menu are listed.</td>
</tr>
<tr>
<td>Config Report</td>
<td>Prints a list of all the product settings. Includes basic network information when the product is connected to a network.</td>
</tr>
<tr>
<td>Supplies Status</td>
<td>Prints the status for each print cartridge, including the following information:</td>
</tr>
<tr>
<td></td>
<td>• Estimated percentage of cartridge life remaining</td>
</tr>
<tr>
<td></td>
<td>• Approximate pages remaining</td>
</tr>
<tr>
<td></td>
<td>• Part numbers for HP print cartridges</td>
</tr>
<tr>
<td></td>
<td>• Number of pages printed</td>
</tr>
<tr>
<td></td>
<td>• Information about ordering new HP print cartridges and recycling used HP print cartridges</td>
</tr>
<tr>
<td>Network Summary</td>
<td>Prints a list of all product network settings</td>
</tr>
<tr>
<td>Usage Page</td>
<td>Prints a page that lists pages that were jammed or mispicked in the product, the number of monochrome (black and white) or color pages, and the total page count.</td>
</tr>
<tr>
<td>PCL Font List</td>
<td>Prints a list of all the PCL fonts that are installed.</td>
</tr>
<tr>
<td>PS Font List</td>
<td>Prints a list of all the PostScript (PS) fonts that are installed</td>
</tr>
<tr>
<td>PCL6 Font List</td>
<td>Prints a list of all the PCL6 fonts that are installed</td>
</tr>
<tr>
<td>Color Usage Log</td>
<td>Prints a report that shows the user name, application name, and color usage information on a job-by-job basis</td>
</tr>
<tr>
<td>Service Page</td>
<td>Prints the service report</td>
</tr>
<tr>
<td>Diagnostics Page</td>
<td>Prints the calibration and color diagnostics pages</td>
</tr>
<tr>
<td>Print Quality Page</td>
<td>Prints a page that helps solve problems with print quality</td>
</tr>
</tbody>
</table>
## Quick Forms menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Sub-menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notebook Paper</td>
<td>Narrow Rule</td>
<td>Prints pages that have preprinted lines</td>
</tr>
<tr>
<td></td>
<td>Wide Rule</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Child Rule</td>
<td></td>
</tr>
<tr>
<td>Graph Paper</td>
<td>1/8 inch</td>
<td>Prints pages that have preprinted graph lines</td>
</tr>
<tr>
<td></td>
<td>5 mm</td>
<td></td>
</tr>
<tr>
<td>Checklist</td>
<td>1-Column</td>
<td>Prints pages that have preprinted lines with check boxes</td>
</tr>
<tr>
<td></td>
<td>2-Column</td>
<td></td>
</tr>
<tr>
<td>Music Paper</td>
<td>Portrait</td>
<td>Prints pages that have preprinted lines for writing music</td>
</tr>
<tr>
<td></td>
<td>Landscape</td>
<td></td>
</tr>
</tbody>
</table>
## System Setup menu

In the following table, items that have asterisks (*) indicate the factory default setting.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Sub-menu item</th>
<th>Sub-menu item</th>
<th>Sub-menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td></td>
<td></td>
<td></td>
<td>Select the language for the control panel display messages and the product reports.</td>
</tr>
<tr>
<td>Paper Setup</td>
<td>Def. Paper Size</td>
<td>Letter</td>
<td></td>
<td>Select the size for printing internal reports or any print job that does not specify a size.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A4</td>
<td>Select the paper type for printing internal reports or any print job that does not specify a type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Legal</td>
<td>Select the default size for Tray 1 from the list of available sizes and types.</td>
</tr>
<tr>
<td></td>
<td>Def. Paper Type</td>
<td></td>
<td></td>
<td>Select the default size and type for Tray 2 from the list of available sizes and types.</td>
</tr>
<tr>
<td></td>
<td>Tray 1 Paper Type</td>
<td>Paper Type</td>
<td></td>
<td>Select the default size and type for Tray 1 from the list of available sizes and types.</td>
</tr>
<tr>
<td></td>
<td>Tray 1 Paper Size</td>
<td></td>
<td></td>
<td>Select the default size and type for Tray 2 from the list of available sizes and types.</td>
</tr>
<tr>
<td>Paper Out Action</td>
<td>Wait Forever*</td>
<td>Cancel</td>
<td>Override</td>
<td>Select how the product should react when a print job requires a size or type that is not available or when a specified tray is empty.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Select the <strong>Wait Forever</strong> option to make the product wait until you load the correct paper and press the <strong>OK</strong> button. This is the default setting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Select the <strong>Override</strong> option to print on a different size or type after a specified delay.</td>
</tr>
<tr>
<td>Print Quality</td>
<td>Calibrate Color</td>
<td>After Power On</td>
<td></td>
<td>Select the <strong>Override</strong> option to print on a different size or type after a specified delay.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Calibrate Now</td>
<td></td>
<td>Select the <strong>Cancel</strong> option to automatically cancel the print job after a specified delay.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>If you select either the <strong>Override</strong> or <strong>Cancel</strong> options, the control panel prompts you to specify the number of seconds to delay. Use the arrow buttons to increase or decrease the time.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>After Power On</td>
<td></td>
<td><strong>After Power On</strong>: Select how soon the product should calibrate after you turn it on. The default setting is <strong>15 Minutes</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Calibrate Now</td>
<td></td>
<td><strong>Calibrate Now</strong>: Makes the product perform a calibration immediately. If a job is processing, the product calibrates after the job is complete. If an error message displays, you must clear the error first.</td>
</tr>
</tbody>
</table>

12 Chapter 2   Control panel menus ENWW
<table>
<thead>
<tr>
<th>Menu item</th>
<th>Sub-menu item</th>
<th>Sub-menu item</th>
<th>Sub-menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Alignment</td>
<td>Print Test Page</td>
<td></td>
<td></td>
<td>Use this menu to shift the margin alignment to center the image on the page from top to bottom and from left to right. Before adjusting these values, print a test page. It provides alignment guides in the X and Y directions so you can determine which adjustments are necessary.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adjust Tray &lt;X&gt;</td>
<td>X1 Shift</td>
<td>Use the X1 Shift setting to center the image from side to side on a single-sided page or for the second side of a two-sided page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>X2 Shift</td>
<td>Use the X2 Shift setting to center the image from side to side on the first side of a two-sided page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Y Shift</td>
<td>Use the Y Shift setting to center the image from top to bottom on the page.</td>
</tr>
<tr>
<td>Energy Settings</td>
<td>Sleep Delay</td>
<td>15 Minutes*</td>
<td></td>
<td>Sets how long the product remains idle before it enters Sleep mode. The product automatically exits Sleep mode when you send a print job or press a control panel button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>30 Minutes</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 Hour</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Hours</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 Minute</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto Power Down</td>
<td>Power Down Delay</td>
<td>30 Minutes*</td>
<td></td>
<td>Select the length of time after which the product automatically turns off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 Hour</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Hours</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 Hours</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>8 Hours</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>24 Hours</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Never</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wake Events</td>
<td>USB Job</td>
<td></td>
<td></td>
<td>Select whether the product wakes when it receives each of these types of jobs or actions. The default for each option is Yes.</td>
</tr>
<tr>
<td></td>
<td>LAN Job</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Wireless Job</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Button Press</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display Contrast</td>
<td>Medium*</td>
<td></td>
<td></td>
<td>Select the level of contrast for the display.</td>
</tr>
<tr>
<td></td>
<td>Darker</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Darkest</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lightest</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lighter</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Menu item</td>
<td>Sub-menu item</td>
<td>Sub-menu item</td>
<td>Sub-menu item</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------</td>
<td>---------------------</td>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Supply Settings</td>
<td>Black Cartridge</td>
<td>Very Low Setting</td>
<td>Prompt*</td>
<td>Set how the product behaves when the black print cartridge reaches the very low threshold.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Continue</td>
<td>• Prompt: The product stops printing and prompts you to replace the print cartridge. You can acknowledge the prompt and continue printing. A customer configurable option on this product is “Prompt to Remind Me in 100 pages, 200 pages, 300 pages, or never.” This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Stop</td>
<td>• Continue: The product alerts you that the print cartridge is very low, but it continues printing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Stop: The product stops printing until you replace the print cartridge.</td>
</tr>
<tr>
<td>Low Threshold</td>
<td>Enter percentage</td>
<td></td>
<td></td>
<td>Use the arrow buttons to increase or decrease the percentage of estimated life remaining at which the product alerts you that the print cartridge is low.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>For the black cartridge that ships with the product, the default is 24%. For the standard replacement black print cartridge, the default is 13%. For the high-capacity replacement black print cartridge, the default is 7%.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>The default values are intended to provide approximately two weeks of use before the cartridge reaches the very low state.</td>
</tr>
<tr>
<td>Menu item</td>
<td>Sub-menu item</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color Cartridges</td>
<td>Very Low Setting</td>
<td>Set how the product behaves when one of the color print cartridges reaches the very low threshold.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stop</td>
<td><strong>Prompt</strong>: The product stops printing and prompts you to replace the print cartridge. You can acknowledge the prompt and continue printing. A customer configurable option on this product is &quot;Prompt to Remind Me in 100 pages, 200 pages, 300 pages, or never.&quot; This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Continue</strong>: The product alerts you that the print cartridge is very low, but it continues printing.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Print Black</strong>: The product has been customer configured to print using only the black print cartridge when the level of a color supply is very low. The color supply might still be able to produce acceptable print quality. To print in color, either replace the color supply or reconfigure the product.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>When you choose to replace the very low print cartridge, color printing resumes automatically.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Stop</strong>: The product stops printing until you replace the print cartridge.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low Threshold</td>
<td>Cyan</td>
<td>Enter percentage</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use the arrow buttons to increase or decrease the percentage of estimated life remaining at which the product alerts you that the print cartridge is low.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Magenta</td>
<td>For the color print cartridges that ship with the product, the default is 16%. For the replacement color print cartridges, the default is 7%.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>The default values are intended to provide approximately two weeks of use before the cartridge reaches the very low state.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Menu item</td>
<td>Sub-menu item</td>
<td>Sub-menu item</td>
<td>Sub-menu item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------</td>
<td>---------------</td>
<td>---------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Store Usage Data</td>
<td>On Supply*</td>
<td>Not on Supply</td>
<td></td>
<td>The product automatically stores print-cartridge usage data in its internal memory. It can also store this data on memory chips in the print cartridges. Select the Not on Supply option to store the data only in the product memory. The information stored on the print cartridge memory chip helps HP design future products to meet our customers’ printing needs. HP collects a sampling of memory chips from print cartridges returned to HP’s free return and recycling program. The memory chips from this sampling are read and studied in order to improve future HP products. The data collected from the print cartridge memory chip does not contain information that can be used to identify a customer or user of the print cartridge or their product.</td>
</tr>
<tr>
<td>Courier Font</td>
<td>Regular*</td>
<td></td>
<td></td>
<td>Select a version of the Courier font.</td>
</tr>
<tr>
<td></td>
<td>Dark</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>


Service menu

Use this menu to restore default settings, clean the product, and activate special modes that affect print output. Items that have asterisks (*) indicate the factory default setting.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Sub-menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cleaning Page</td>
<td></td>
<td>Use this option to clean the product if you see toner specks or other marks on the printed output. The cleaning process removes dust and excess toner from the paper path. When you select this item, the product prompts you to load plain paper in Tray 1 and then press the OK button to start the cleaning process. Wait until the process is complete. Discard the page that prints. <strong>NOTE:</strong> For models that do not have an automatic duplexer, the product prints the first side and then prompts you to remove the page from the output bin and reload it in Tray 1, keeping the same orientation.</td>
</tr>
<tr>
<td>USB Speed</td>
<td>High*</td>
<td>For the product to actually operate at high speed, it must have high speed enabled and be connected to an EHCI host controller that is also operating at high speed. This menu item also does not reflect the current operating speed of the product.</td>
</tr>
<tr>
<td></td>
<td>Full</td>
<td></td>
</tr>
<tr>
<td>Less Paper Curl</td>
<td>On*</td>
<td>If printed pages are consistently curled, use this option to set the product to a mode that reduces curl.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Archive Print</td>
<td>On*</td>
<td>If you are printing pages that will be stored for a long time, use this option to set the product to a mode that reduces toner smearing and dusting.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Firmware Date</td>
<td></td>
<td>Displays the current firmware datecode.</td>
</tr>
<tr>
<td>Restore Defaults</td>
<td></td>
<td>Sets all customized menu settings to the factory default values.</td>
</tr>
<tr>
<td>HP Smart Install</td>
<td>On*</td>
<td>Enable or disable the HP Smart Install tool.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Disable the tool if you want to connect to a network by using an Ethernet cable. If you disable HP Smart Install, you must use the product software CD to install the product software.</td>
</tr>
</tbody>
</table>
## Network Setup menu

Use this menu to establish network configuration settings. Items that have asterisks (*) indicate the factory default setting.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Sub-menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Wireless Menu</strong> (wireless products only)</td>
<td>Direct WiFi</td>
<td>Provides the product's Direct WiFi name, so you can access it from other wireless devices that support the Wi-Fi Direct protocol.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> You can also access this menu by pressing the Wireless button on the front of the product.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>WPS Setup</strong></td>
<td></td>
<td>If your wireless router supports this feature, use this method to set up the product on a wireless network. This is the simplest method.</td>
</tr>
<tr>
<td><strong>Network Test</strong></td>
<td></td>
<td>Tests the wireless network and prints a report with the results.</td>
</tr>
<tr>
<td><strong>Wireless Off/On</strong></td>
<td></td>
<td>Enable or disable the wireless network feature.</td>
</tr>
<tr>
<td><strong>TCP IP Config</strong></td>
<td>Automatic*</td>
<td>Select the Automatic option to automatically configure all the TCP/IP settings.</td>
</tr>
<tr>
<td></td>
<td>Manual</td>
<td>Select the Manual option to manually configure the IP address, subnet mask, and default gateway.</td>
</tr>
<tr>
<td>Auto Crossover</td>
<td>On*</td>
<td>Enables or disables the use of a standard 10/100 network cable when the product is directly connected to a computer.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Network Services</td>
<td>IPv4</td>
<td>Enable or disable the IPv4 and IPv6 protocols. By default, each protocol is enabled.</td>
</tr>
<tr>
<td></td>
<td>IPv6</td>
<td></td>
</tr>
<tr>
<td>Show IP Address</td>
<td>No</td>
<td><strong>No:</strong> The product IP address will not appear on the control panel display.</td>
</tr>
<tr>
<td></td>
<td>Yes*</td>
<td><strong>Yes:</strong> The product IP address will appear on the control panel display.</td>
</tr>
<tr>
<td>Link Speed</td>
<td>Automatic*</td>
<td>Sets the link speed manually if needed.</td>
</tr>
<tr>
<td></td>
<td>10T Full</td>
<td>After setting the link speed, the product automatically restarts.</td>
</tr>
<tr>
<td></td>
<td>10T Half</td>
<td></td>
</tr>
<tr>
<td></td>
<td>100TX Full</td>
<td></td>
</tr>
<tr>
<td></td>
<td>100TX Half</td>
<td></td>
</tr>
<tr>
<td>HTTPS Enforced</td>
<td>No*</td>
<td>Sets the product so it communicates only with Web sites that use hypertext transfer protocol secure (HTTPS).</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Restore Defaults</td>
<td></td>
<td>Restores the network configuration settings to the default values.</td>
</tr>
</tbody>
</table>
3 Software for Windows

- Supported operating systems and printer drivers for Windows
- Select the correct printer driver for Windows
- Change print job settings for Windows
- Remove the printer driver from Windows
- Supported utilities for Windows
- Software for other operating systems
Supported operating systems and printer drivers for Windows

The product supports the following Windows operating systems:

- Windows XP (32-bit, Service Pack 2)
- Windows Server 2003 (32-bit, Service Pack 3)
- Windows Server 2008 (32-bit and 64-bit)
- Windows Vista (32-bit and 64-bit)
- Windows 7 (32-bit and 64-bit)

The product supports the following Windows printer drivers:

- HP PCL 6 (this is the default printer driver included on the product CD and in the HP Smart Install program)
- HP Universal Print Driver for Windows Postscript
- HP Universal Print Driver for PCL 5

The printer drivers include online Help that has instructions for common printing tasks and also describes the buttons, check boxes, and drop-down lists that are in the printer driver.

**NOTE:** For more information about the universal print driver (UPD), see [www.hp.com/go/upd](http://www.hp.com/go/upd).

Select the correct printer driver for Windows

Printer drivers provide access to the product features and allow the computer to communicate with the product (using a printer language). The following printer drivers are available at [www.hp.com/go/LJColorM351_software](http://www.hp.com/go/LJColorM351_software) or [www.hp.com/go/LJColorM451_software](http://www.hp.com/go/LJColorM451_software).

<table>
<thead>
<tr>
<th>HP PCL 6 driver</th>
<th>Provided as the default driver. This driver is automatically installed unless you select a different one.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Recommended for all Windows environments</td>
</tr>
<tr>
<td></td>
<td>Provides the overall best speed, print quality, and product-feature support for most users</td>
</tr>
<tr>
<td></td>
<td>Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in Windows environments</td>
</tr>
<tr>
<td></td>
<td>Might not be fully compatible with third-party and custom software programs that are based on PCL 5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HP UPD PS driver</th>
<th>Recommended for printing with Adobe® software programs or with other highly graphics-intensive software programs</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Provides support for printing from postscript emulation needs, or for postscript flash font support</td>
</tr>
</tbody>
</table>
| HP UPD PCL 5 | • Recommended for general office printing in Windows environments  
| | • Compatible with previous PCL versions and older HP LaserJet products  
| | • The best choice for printing from third-party or custom software programs  
| | • The best choice when operating with mixed environments, which require the product to be set to PCL 5 (UNIX, Linux, mainframe)  
| | • Designed for use in corporate Windows environments to provide a single driver for use with multiple printer models  
| | • Preferred when printing to multiple printer models from a mobile Windows computer |
| HP UPD PCL 6 | • Recommended for printing in all Windows environments  
| | • Provides the overall best speed, print quality, and printer feature support for most users  
| | • Developed to align with Windows Graphic Device Interface (GDI) for best speed in Windows environments  
| | • May not be fully compatible with third-party and custom solutions based on PCL5 |
HP Universal Print Driver (UPD)

The HP Universal Print Driver (UPD) for Windows is a single driver that gives you instant access to virtually any HP LaserJet product, from any location, without downloading separate drivers. It is built on proven HP print driver technology and has been tested thoroughly and used with many software programs. It is a powerful solution that performs consistently over time.

The HP UPD communicates directly with each HP product, gathers configuration information, and then customizes the user interface to show the product’s unique, available features. It automatically enables features that are available for the product, such as two-sided printing and stapling, so you do not need to enable them manually.

For more information, go to [www.hp.com/go/upd](http://www.hp.com/go/upd).

UPD installation modes

<table>
<thead>
<tr>
<th>Traditional mode</th>
<th>Use this mode if you are installing the driver from a CD for a single computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>When installed from the CD that comes with the product, UPD operates like traditional printer drivers. It operates with a specific product.</td>
</tr>
<tr>
<td></td>
<td>If you use this mode, you must install UPD separately for each computer and for each product.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dynamic mode</th>
<th>To use this mode, download UPD from the Internet. See <a href="http://www.hp.com/go/upd">www.hp.com/go/upd</a>.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Dynamic mode allows you to use a single driver installation, so you can discover and print to HP products in any location.</td>
</tr>
<tr>
<td></td>
<td>Use this mode if you are installing UPD for a workgroup.</td>
</tr>
</tbody>
</table>


Change print job settings for Windows

Priority for print settings

Changes to print settings are prioritized depending on where the changes are made:

**NOTE:** The names of commands and dialog boxes might vary depending on your software program.

- **Page Setup dialog box:** Click Page Setup or a similar command on the File menu of the program you are working in to open this dialog box. Settings changed here override settings changed anywhere else.

- **Print dialog box:** Click Print, Print Setup, or a similar command on the File menu of the program you are working in to open this dialog box. Settings changed in the Print dialog box have a lower priority and usually do not override changes made in the Page Setup dialog box.

- **Printer Properties dialog box (printer driver):** Click Properties in the Print dialog box to open the printer driver. Settings changed in the Printer Properties dialog box usually do not override settings anywhere else in the printing software. You can change most of the print settings here.

- **Default printer driver settings:** The default printer driver settings determine the settings used in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog boxes.

- **Printer control panel settings:** Settings changed at the printer control panel have a lower priority than changes made anywhere else.

Change the settings for all print jobs until the software program is closed

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

The steps can vary; this procedure is most common.

Change the default settings for all print jobs

1. **Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu view):** Click Start, and then click Printers and Faxes.


Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Printing Preferences.
Change the product configuration settings

1. **Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu view):** Click Start, and then click Printers and Faxes.

   **Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu view):** Click Start, click Settings, and then click Printers.

   **Windows Vista:** Click Start, click Control Panel, and then in the category for Hardware and Sound click Printer.

   **Windows 7:** Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Device Settings tab.
Remove the printer driver from Windows

**Windows XP**
1. Click the **Start** button, , and then click the **Printers and Faxes** item.
2. Find and right-click the product from the list, and then click the **Delete** item.
3. From the **File** menu, click the **Server Properties** item. The **Print Server Properties** dialog box opens.
4. Click the **Drivers** tab, and in the list, select the driver to be removed.
5. Click the **Remove** button, and then click the **Yes** button to confirm the removal.

**Windows Vista**
1. Click the **Start** button , and then click the **Control Panel** item.
2. In the **Hardware and Sound** group, click the **Printer** item.
3. Find and right-click the product, click the **Delete** item, and then click the **Yes** button to confirm the removal.
4. From the **File** menu, click the **Server Properties** item. The **Print Server Properties** dialog box opens.
5. Click the **Drivers** tab, and in the list, select the driver to be removed.
6. Click the **Remove** button, and then click the **Yes** button to confirm the removal.

**Windows 7**
1. Click the **Start** button, and then click the **Devices and Printers** item.
2. Find and select the product from the list.
3. Click the **Remove device** button at the top of the dialog box, and then click the **Yes** button to confirm the removal.
4. Click the **Print server properties** button at the top of the dialog box, and then click the **Drivers** tab.
5. Select the product in the list, and then click the **Remove** button.
6. Select to delete only the driver and or the driver software package, and then click the **OK** button

**Supported utilities for Windows**

- HP Web Jetadmin
- HP Embedded Web Server
- HP ePrint
Other Windows components and utilities

- HP Smart Install — automates the printing system installation
- Online Web registration
- HP Device Toolbox
- HP Uninstall
- HP Help & Learn Center
- Reconfigure your HP device
- HP LaserJet Customer Participation Program

Software for other operating systems

<table>
<thead>
<tr>
<th>OS</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNIX</td>
<td>For HP-UX and Solaris networks, go to <a href="https://www.hp.com/support/net_printing">www.hp.com/support/net_printing</a> to download the HP Jetdirect printer installer for UNIX. For Unix print drivers, go to <a href="https://www.hp.com/pond/modelscripts/index2">www.hp.com/pond/modelscripts/index2</a>.</td>
</tr>
<tr>
<td>Linux</td>
<td>For information, go to <a href="https://www.hp.com/go/linuxprinting">www.hp.com/go/linuxprinting</a>.</td>
</tr>
</tbody>
</table>
4 Use the product with Mac

- Software for Mac
- Basic print tasks with Mac
- Use AirPrint
- Solve problems with Mac
Software for Mac

Supported operating systems and printer drivers for Mac

The product supports the following Mac operating systems:

- Mac OS X 10.5 and 10.6

NOTE: For Mac OS X 10.5 and later, PPC and Intel® Core™ Processor Macs are supported. For Mac OS X 10.6, Intel Core Processor Macs are supported.

The HP LaserJet software installer provides PostScript® Printer Description (PPD) files, Printer Dialog Extensions (PDEs), and the HP Utility for use with Mac OS X computers. The HP printer PPD and PDE files, in combination with the built-in Apple PostScript printer drivers, provide full printing functionality and access to specific HP printer features.

Install software for Mac operating systems

Install software for Mac computers connected directly to the product

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a cable that is no longer than 2 m (6.5 ft).

1. Connect the USB cable to the product and the computer.

2. Install the software from the CD.

3. Click HP Installer icon, and follow the onscreen instructions.

4. On the Congratulations screen, click the OK button.

5. Print a page from any program to make sure that the printing software is correctly installed.
Install software for Mac computers on a wired network

Configure the IP address

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and assigns an IP address or host name for the product.

Install the software

1. Install the software from the CD. Click the product icon, and follow the onscreen instructions.

2. Print a page from any program to make sure that the software is correctly installed.

Install software for Mac computers on a wireless network

Before installing the product software, make sure the product is not connected to the network using a network cable. Make sure your Mac computer is connected to the same wireless network to which you plan to connect the product.

Use one of the following procedures to connect the product to the wireless network.

- Connect the product to a wireless network using WPS by using the control panel menus
- Connect the product to a wireless network using a USB cable

If your router supports Wi-Fi Protected Setup (WPS), use that method to add the product to your network. This is the simplest way to set up the product on a wireless network.

**NOTE:** Apple AirPort wireless routers do not support WPS button setup.

If your wireless router does not support Wi-Fi Protected Setup (WPS), obtain the wireless router network settings from your system administrator, or complete the following tasks:

- Obtain the wireless network name or service set identifier (SSID).
- Determine the security password or encryption key for the wireless network.
Connect the product to a wireless network using WPS by using the control panel menus

1. On the front of the product, press the Wireless button. Look at the control panel display to see if the Wireless Menu item has opened. If it has not opened, complete these steps:
   a. At the control panel, press the OK button to open the menus.
   b. Open the following menus:
      - Network Setup
      - Wireless Menu

2. Select the WPS Setup item.

3. Use one of these methods to complete the setup:
   - **Pushbutton**: Select the Pushbutton option and follow the instructions on the control panel. Establishing the wireless connection can take a few minutes.
   - **PIN**: Select the Generate PIN option. The product generates a unique PIN, which you must type into the wireless router's setup screen. Establishing the wireless connection can take a few minutes.

4. At the computer, open the Apple menu, click the System Preferences menu, and then click the Print & Fax icon.

5. Click the plus (+) symbol in the lower left corner of the Printer Names column.
   
   By default, Mac OS X uses the Bonjour method to find the product over the local network and add it to the printer pop-up menu. This method is best in most situations. If Mac OS X cannot find the HP printer driver, an error message displays. Reinstall the software.

6. Print a page from any program to make sure that the software is correctly installed.

    **NOTE:** If this method is not successful, try using the wireless network using a USB cable method.

Connect the product to a wireless network using a USB cable

If your wireless router does not support WiFi-Protected Setup (WPS), use this method to set up the product on a wireless network. Using a USB cable to transfer settings makes setting up a wireless connection easier. After the setup is complete, you can disconnect the USB cable and use the wireless connection.

1. Insert the software CD into the computer CD tray.

2. Follow the on-screen instructions. When prompted, select the Configure your device for a wireless network option. Connect the USB cable to the product when prompted.

    **CAUTION:** Do not connect the USB cable until the installation program prompts you.

3. When the installation is complete, print a configuration page to make sure that the product has a SSID name.

4. Print a page from any program to make sure that the software is correctly installed.
Remove the printer driver from Mac operating systems

You must have administrator rights to remove the software.

1. Open **System Preferences**.
2. Select **Print & Fax**.
3. Highlight the product.
4. Click the minus (-) symbol.
5. Delete the print queue, if necessary.

Priority for print settings for Mac

Changes to print settings are prioritized depending on where the changes are made:

- **Page Setup dialog box**: Click **Page Setup** or a similar command on the **File** menu of the program you are working in to open this dialog box. Settings changed here might override settings changed anywhere else.

- **Print dialog box**: Click **Print**, **Print Setup**, or a similar command on the **File** menu of the program you are working in to open this dialog box. Settings changed in the **Print** dialog box have a lower priority and do **not** override changes made in the **Page Setup** dialog box.

- **Default printer driver settings**: The default printer driver settings determine the settings used in all print jobs, unless settings are changed in the **Page Setup**, **Print**, or **Printer Properties** dialog boxes.

- **Printer control panel settings**: Settings changed at the printer control panel have a lower priority than changes made anywhere else.

Change printer-driver settings for Mac

Change the settings for all print jobs until the software program is closed

1. On the **File** menu, click the **Print** button.
2. Change the settings that you want on the various menus.

Change the default settings for all print jobs

1. On the **File** menu, click the **Print** button.
2. Change the settings that you want on the various menus.
3. On the **Presets** menu, click the **Save As...** option and type a name for the preset.
These settings are saved in the Presets menu. To use the new settings, you must select the saved preset option every time you open a program and print.

Change the product configuration settings

1. From the Apple menu, click the System Preferences menu and then click the Print & Fax icon.
2. Select the product in the left side of the window.
3. Click the Options & Supplies button.
4. Click the Driver tab.
5. Configure the installed options.

Software for Mac computers

HP Utility for Mac

Use the HP Utility to set up product features that are not available in the printer driver.

You can use the HP Utility when the product uses a universal serial bus (USB) cable or is connected to a TCP/IP-based network.

Open the HP Utility

▲ From the dock, click HP Utility.

-or-

From Applications, open the Hewlett-Packard folder, and then click HP Utility.

HP Utility features

Use the HP Utility software to perform the following tasks:

- Obtain information about supplies status.
- Obtain information about the product, such as the firmware version and the serial number.
- Print a configuration page.
- For products connected to an IP-based network, obtain network information and open the HP Embedded Web Server.
- Configure the paper type and size for the tray.
- Transfer files and fonts from the computer to the product.
- Update the product firmware.
- Display the color usage page.
**Supported utilities for Mac**

**HP Embedded Web Server**

The product is equipped with the HP Embedded Web server, which provides access to information about product and network activities. Access the HP Embedded Web Server from the HP Utility. Open the **Printer Settings** menu, and then select the **Additional Settings** option.

You can also access the HP Embedded Web Server from the Safari Web browser:

1. Select the page icon in the left side of the Safari toolbar.
2. Click the Bonjour logo.
3. In the list of printers, double-click this product. The HP Embedded Web Server opens.

**HP ePrint**

With HP ePrint, you can print anywhere, anytime, from a mobile phone, laptop, or any other mobile device. HP ePrint works with any email-capable device. If you can e-mail, you can print to an HP ePrint-enabled product. For more details, go to [www.hpeprintcenter.com](http://www.hpeprintcenter.com).

**NOTE:** The product must be connected to a network and have Internet access to use HP ePrint.

HP ePrint is disabled as a default setting in the product. Use this procedure to enable it.

1. Type the product IP address into the address line of a Web browser to open the HP Embedded Web Server.
2. Click the **HP Web Services** tab.
3. Select the option to enable Web Services.

**AirPrint**

Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to the product from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) in the following applications:

- Mail
- Photos
- Safari
- Select third-party applications

To use AirPrint, the product must be connected to a wireless network. For more information about using AirPrint and about which HP products are compatible with AirPrint, go to [www.hp.com/go/airprint](http://www.hp.com/go/airprint).

**NOTE:** You might need to upgrade the product firmware to use AirPrint. Go to [www.hp.com/support/LJColorM351](http://www.hp.com/support/LJColorM351) or [www.hp.com/support/LJColorM451](http://www.hp.com/support/LJColorM451).
Basic print tasks with Mac

Cancel a print job with Mac

1. If the print job is currently printing, cancel it by pressing the Cancel \(\times\) button on the product control panel.

   **NOTE:** Pressing the Cancel \(\times\) button clears the job that the product is currently processing. If more than one process is running, pressing the Cancel \(\times\) button clears the process that currently appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.
   - **Software program:** Typically, a dialog box appears briefly on the computer screen, allowing you to cancel the print job.
   - **Print queue:** Open the print queue by double-clicking the product icon in the dock. Highlight the print job, and then click **Delete**.

Change the paper size and type with Mac

1. On the **File** menu in the software program, click the **Print** option.

2. In the **Copies & Pages** menu, click the **Page Setup** button.

3. Select a size from the **Paper Size** drop-down list, and then click the **OK** button.

4. Open the **Finishing** menu.

5. Select a type from the **Media-type** drop-down list.

6. Click the **Print** button.

Resize documents or print on a custom paper size with Mac

<table>
<thead>
<tr>
<th>Mac OS X 10.5 and 10.6</th>
<th>1. On the <strong>File</strong> menu, click the <strong>Print</strong> option.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. Click the <strong>Page Setup</strong> button.</td>
</tr>
<tr>
<td></td>
<td>3. Select the product, and then select the correct settings for the <strong>Paper Size</strong> and <strong>Orientation</strong> options.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mac OS X 10.5 and 10.6</th>
<th>1. On the <strong>File</strong> menu, click the <strong>Print</strong> option.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. Open the <strong>Paper Handling</strong> menu.</td>
</tr>
<tr>
<td></td>
<td>3. In the <strong>Destination Paper Size</strong> area, click the <strong>Scale to fit paper size</strong> box, and then select the size from the drop-down list.</td>
</tr>
</tbody>
</table>

Create and use printing presets with Mac

Use printing presets to save the current printer driver settings for reuse.
Create a printing preset

1. On the File menu, click the Print option.
2. Select the driver.
3. Select the print settings that you want to save for reuse.
4. In the Presets menu, click the Save As... option, and type a name for the preset.
5. Click the OK button.

Use printing presets

1. On the File menu, click the Print option.
2. Select the driver.
3. In the Presets menu, select the printing preset.

NOTE: To use printer-driver default settings, select the standard option.

Print a cover page with Mac

1. On the File menu, click the Print option.
2. Select the driver.
3. Open the Cover Page menu, and then select where to print the cover page. Click either the Before Document button or the After Document button.
4. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the standard option from the Cover Page Type menu.

Use watermarks with Mac

1. On the File menu, click the Print option.
2. Open the Watermarks menu.
3. From the Mode menu, select the type of watermark to use. Select the Watermark option to print a semi-transparent message. Select the Overlay option to print a message that is not transparent.
4. From the Pages menu, select whether to print the watermark on all pages or on the first page only.
5. From the Text menu, select one of the standard messages, or select the Custom option and type a new message in the box.
6. Select options for the remaining settings.
Print multiple pages on one sheet of paper with Mac

1. On the File menu, click the Print option.
2. Select the driver.
3. Open the Layout menu.
4. From the Pages per Sheet menu, select the number of pages that you want to print on each sheet (1, 2, 4, 6, 9, or 16).
5. In the Layout Direction area, select the order and placement of the pages on the sheet.
6. From the Borders menu, select the type of border to print around each page on the sheet.

Print on both sides of the page (duplex printing) with Mac

Use automatic duplex printing

1. Insert enough paper into one of the trays to accommodate the print job.
2. On the File menu, click the Print option.
3. Open the Layout menu.
4. From the Two-Sided menu, select a binding option.

Print on both sides manually

1. Insert enough paper into one of the trays to accommodate the print job.
2. On the File menu, click the Print option.
3. Open the Finishing menu, and click the Manual Duplex tab or open the Manual Duplex menu.
4. Click the Manual Duplex box, and select a binding option.
5. Click the Print button. Follow the instructions in the pop-up window that appears on the computer screen before replacing the output stack in Tray 1 for printing the second half.
6. Go to the product, and remove any blank paper that is in Tray 1.

7. Insert the printed stack face-up with the bottom edge feeding into the printer first in Tray 1. You must print the second side from Tray 1.

8. If prompted, press the appropriate control-panel button to continue.

**Set the color options with Mac**

If you are using the HP Postscript printer driver for Mac, HP EasyColor technology scans all documents and automatically adjusts all photographic images with the same improved photographic results.

In the following example, the images on the left were created without using the HP EasyColor option. The images on the right show the enhancements that result from using the HP EasyColor option.

The HP EasyColor option is enabled by default in the HP Mac Postscript printer driver, so you do not need to make manual color adjustments. To disable the option so you can manually adjust the color settings, use the following procedure.

1. On the **File** menu, click the **Print** option.

2. Select the driver.

3. Open the **Color/Quality Options** menu, and then click the **HP EasyColor** check box to clear it.

4. Open the **Advanced** menu, or select the appropriate tab.

5. Adjust the individual settings for text, graphics, and photographs.
Use AirPrint

Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to the product from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) in the following applications:

- Mail
- Photos
- Safari
- Select third-party applications

To use AirPrint, the product must be connected to a network. For more information about using AirPrint and about which HP products are compatible with AirPrint, go to www.hp.com/go/airprint.

**NOTE:** You might need to upgrade the product firmware to use AirPrint. Go to www.hp.com/support/LJColorM351 or www.hp.com/support/LJColorM451.
Solve problems with Mac

For information about solving problems with a Mac, see Solve product software problems with Mac on page 180.
5 Connect the product with Windows

- Printer sharing disclaimer
- Use HP Smart Install to connect to a computer, a wired network, or a wireless network
- Connect with USB
- Connect to a network with Windows
Printer sharing disclaimer

HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

Use HP Smart Install to connect to a computer, a wired network, or a wireless network

NOTE: This installation type is supported for Windows only.

The software installation files are in the product memory. The HP Smart Install program uses a USB cable to transfer the installation files from the product to your computer. This installer supports USB connections, wired networks, and wireless networks. It installs all files you need to print. To use the HP Smart Install program, follow one of these procedures, depending on your connection type.

NOTE: If you prefer not to use the HP Smart Install program, you can insert the product CD to install the software.

HP Smart Install for Windows direct connections (USB)

1. Connect an A-to-B type USB cable to the computer and the product. The HP Smart Install program might take a few minutes to start.
2. Follow the onscreen instructions.

NOTE: The HP Smart Install program might take a few minutes to start. If the installation program does not start automatically, the AutoPlay feature might be disabled on the computer. In Windows Explorer, browse the computer, and then double-click the HP Smart Install driver and run the installation program.

NOTE: If the HP Smart Install program fails, disconnect the USB cable, turn the product off and then on again, and then insert the product CD into your computer. Follow the onscreen instructions. Connect the cable only when the software prompts you.

HP Smart Install for Windows wired networks

1. Connect a network cable to the product and a network port. Allow a few minutes for an IP address to be assigned.
2. On the product control panel, the product IP address alternates with the Ready message on the display. Make note of the IP address.
3. At the computer, open a Web browser and type the IP address in the URL address bar to open the HP Embedded Web Server. Click the HP Smart Install tab and follow the onscreen instructions.

NOTE: If the HP Smart Install program fails, insert the product CD into your computer. Follow the onscreen instructions.
HP Smart Install for Windows wireless networks, method 1: Temporarily connect a USB cable

1. Connect an A-to-B type USB cable to the computer and the product. The HP Smart Install program might take a few minutes to start.
2. Follow the onscreen instructions. Choose wireless network for the install type. Remove the USB cable when instructed.

HP Smart Install for Windows wireless networks, method 2: Use WPS

1. On the front of the product, press the Wireless button to open the Wireless Menu options.
2. Press the OK button to select the Wireless Off/On option, and then press the right arrow to select the On option. Press the OK button to save the setting.
3. Press the right arrow to select the WPS Setup option, and then press the OK button. Follow the instructions to complete the wireless setup.
4. On the product control panel, the product IP address alternates with the Ready message on the display. Make note of the IP address.
5. At the computer, open a Web browser and type the IP address in the URL address bar to open the HP Embedded Web Server. Click the HP Smart Install tab and follow the onscreen instructions.

Connect with USB

NOTE: Use this procedure if you are not using the HP Smart Install.

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a cable that is no longer than 2 m (6.5 ft).

CAUTION: Do not connect the USB cable until the installation software prompts you to connect it.

CD installation

1. Quit all open programs on the computer.
2. Install the software from the CD, and follow the on-screen instructions.
3. When prompted, select the Directly connect to this computer using a USB cable option, and then click the Next button.
4. When the software prompts you, connect the USB cable to the product and the computer.

5. At the end of the installation, click the **Finish** button.

6. On the **More Options** screen, you can install more software, or click the **Finish** button.

7. Print a page from any program to make sure that the printing software is correctly installed.
Connect to a network with Windows

Supported network protocols

To connect a networking-equipped product to a network, you need a network that uses one or more of the following protocols.

- TCP/IP (IPv4 or IPv6)
- LPD Printing
- SLP
- WS-Discovery

Install the product on a wired network with Windows

**NOTE:** Use this procedure if you are not using the HP Smart Install.

Obtain the IP address

1. Connect the network cable to the product and to the network. Turn the product on.

![Connect the network cable to the product and to the network. Turn the product on.]

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and assigns an IP address or host name for the product.

3. At the product control panel, press the OK button.

4. Press the right arrow ⬆ to highlight the Reports menu, and then press the OK button.

5. Press the right arrow ⬆ to highlight the Config Report option, and then press the OK button.
6. Find the IP address on the Self Test/Configuration page.

---

**Install the software**

1. Quit all programs on the computer.
2. Install the software from the CD.
3. Follow the onscreen instructions.
4. When prompted, select the **Connect through a wired network** option, and then click the **Next** button.
5. From the list of available printers, select the printer that has the correct IP address.
6. Click the **Finish** button.
7. On the **More Options** screen, you can install more software, or click the **Finish** button.
8. Print a page from any program to make sure that the printing software is correctly installed.

---

**Install the product on a wireless network with Windows (wireless models only)**

**NOTE:** Use this procedure if you are not using the HP Smart Install.

Before installing the product software, make sure the product is not connected to the network using a network cable.

If your wireless router does not support Wi-Fi Protected Setup (WPS), obtain the wireless router network settings from your system administrator, or complete the following tasks:

- Obtain the wireless network name or service set identifier (SSID).
- Determine the security password or encryption key for the wireless network.
Connect the product to a wireless network using WPS

If your wireless router supports Wi-Fi Protected Setup (WPS), this is the simplest way to set up the product on a wireless network.

1. Press the WPS button on your wireless router.
2. Press and hold the Wireless button on the product control panel for two seconds. Release the button when the wireless light starts blinking.
3. Wait up to two minutes while the product establishes a network connection with the wireless router.

NOTE: If this method is not successful, try using the wireless network using USB cable method.

Connect the product to a wireless network using WPS by using the control panel menus

1. On the front of the product, press the Wireless button. Look at the control panel display to see if the Wireless Menu item has opened. If it has not opened, complete these steps:
   a. At the control panel, press the OK button to open the menus.
   b. Open the following menus:
      - Network Setup
      - Wireless Menu
2. Select the WPS Setup item.
3. Use one of these methods to complete the setup:
   - **Pushbutton**: Select the Pushbutton option and follow the instructions on the control panel. Establishing the wireless connection can take a few minutes.
   - **PIN**: Select the Generate PIN option. The product generates a unique PIN, which you must type into the wireless router's setup screen. Establishing the wireless connection can take a few minutes.

NOTE: If this method is not successful, try using the wireless network using a USB cable method.

Connect the product to a wireless network using a USB cable

If your wireless router does not support WiFi-Protected Setup (WPS), use this method to set up the product on a wireless network. Using a USB cable to transfer settings makes setting up a wireless
connection easier. After the setup is complete, you can disconnect the USB cable and use the wireless connection.

1. Insert the software CD into the computer CD tray.

2. Follow the on-screen instructions. When prompted, select the **Connect through a wireless network** option. Connect the USB cable to the product when prompted.

   **CAUTION:** Do not connect the USB cable until the installation program prompts you.

3. When the installation is complete, print a configuration page to make sure that the product has a SSID name.

4. When installation is complete, disconnect the USB cable.

### Install the software for a wireless product currently on the network

If the product already has an IP address on a wireless network and you want to install product software on a computer, complete the following steps.

1. From the product control panel, print a configuration page to obtain the product IP address.

2. Install the software from the CD.

3. Follow the on-screen instructions.

4. When prompted, select the **Connect through a wireless network** option, and then click the **Next** button.

5. From the list of available printers, select the printer that has the correct IP address.
**Configure IP network settings with Windows**

**View or change network settings**

Use the embedded Web server to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.
   - If you are using IPv4, the IP address contains only digits. It has this format: `xxx.xxx.xxx.xxx`
   - If you are using IPv6, the IP address is a hexadecimal combination of characters and digits. It has a format similar to this: `xxxx::xxxx:xxxx:xxxx:xxxx`

2. To open the HP Embedded Web Server, type the IP address (IPv4) into the address line of a Web browser. For IPv6, use the protocol established by the Web browser for entering IPv6 addresses.

3. Click the **Networking** tab to obtain network information. You can change settings as needed.

**Set or change the product password**

Use the HP Embedded Web Server to set a password or change an existing password for a product on a network.

1. Type the product IP address into the address line of a Web browser. Click the **Networking** tab, and click the **Security** link.
   - **NOTE:** If a password has previously been set, you are prompted to type the password. Type the password, and then click the **Apply** button.

2. Type the new password in the **New Password** box and in the **Verify password** box.

3. At the bottom of the window, click the **Apply** button to save the password.

**Manually configure IPv4 TCP/IP parameters from the control panel**

1. At the control panel, press the **OK** button to open the menus.

2. Open the following menus:
   - **Network Setup**
   - **TCP IP Config**
   - **Manual**

3. Use the arrow buttons to change each digit of the IP address. Press the **OK** button to move to the next digit.
Link speed and duplex settings

NOTE: This information applies only to Ethernet networks. It does not apply to wireless networks.

NOTE: Incorrect changes to the link speed setting might prevent the product from communicating with other network devices. For most situations, the product should be left in automatic mode. Changes can cause the product to turn off and then on. Changes should be made only while the product is idle.

1. At the control panel, press the OK button to open the menus.

2. Open the following menus:
   - Network Setup
   - Link Speed

3. Use the arrow buttons to select one of the following settings.
   - Automatic
   - 10T Full
   - 10T Half
   - 100TX Full
   - 100TX Half

NOTE: The setting must match with the network product to which you are connecting (a network hub, switch, gateway, router, or computer).

4. Press the OK button. The product turns off and then on.
6  Paper and print media

- Understand paper use
- Change the printer driver to match the paper type and size in Windows
- Supported paper sizes
- Supported paper types and tray capacity
- Load paper trays
- Configure trays
Understand paper use

This product supports a variety of paper and other print media. Paper or print media that does not meet the following guidelines might cause poor print quality, increased jams, and premature wear on the product.

It is possible for paper to meet all of these guidelines and still not produce satisfactory results. This might be the result of improper handling, unacceptable temperature and/or humidity levels, or other variables over which Hewlett-Packard has no control.

⚠️ **CAUTION:** Using paper or print media that does not meet Hewlett-Packard's specifications might cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard warranty or service agreements.

- For best results, use only HP-brand paper and print media designed for laser printers or multiuse.
- Do not use paper or print media made for inkjet printers.

⚠️ **CAUTION:** HP LaserJet products use fusers to bond dry toner particles to the paper in very precise dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper could damage the product.

- Hewlett-Packard Company cannot recommend the use of other brands of media because HP cannot control their quality.

Use the following guidelines to obtain satisfactory results when using special paper or print media. Set the paper type and size in the printer driver to obtain the best results.

<table>
<thead>
<tr>
<th>Media type</th>
<th>Do</th>
<th>Do not</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelopes</td>
<td>• Store envelopes flat.</td>
<td>• Do not use envelopes that are wrinkled, nicked, stuck together, or otherwise damaged.</td>
</tr>
<tr>
<td></td>
<td>• Use envelopes where the seam extends all the way to the corner of the envelope.</td>
<td>• Do not use envelopes that have clasps, snaps, windows, or coated linings.</td>
</tr>
<tr>
<td></td>
<td>• Use peel-off adhesive strips that are approved for use in laser printers.</td>
<td>• Do not use self-stick adhesives or other synthetic materials.</td>
</tr>
<tr>
<td>Labels</td>
<td>• Use only labels that have no exposed backing between them.</td>
<td>• Do not use labels that have wrinkles or bubbles, or are damaged.</td>
</tr>
<tr>
<td></td>
<td>• Use labels that lie flat.</td>
<td>• Do not print partial sheets of labels.</td>
</tr>
<tr>
<td></td>
<td>• Use only full sheets of labels.</td>
<td></td>
</tr>
<tr>
<td>Transparencies</td>
<td>• Use only transparencies that are approved for use in color laser printers.</td>
<td>• Do not use transparent print media not approved for laser printers.</td>
</tr>
<tr>
<td></td>
<td>• Place transparencies on a flat surface after removing them from the product.</td>
<td></td>
</tr>
<tr>
<td>Media type</td>
<td>Do</td>
<td>Do not</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Letterhead or preprinted forms</td>
<td>• Use only letterhead or forms approved for use in laser printers.</td>
<td>• Do not use raised or metallic letterhead.</td>
</tr>
<tr>
<td>Heavy paper</td>
<td>• Use only heavy paper that is approved for use in laser printers and meets the weight specifications for this product.</td>
<td>• Do not use paper that is heavier than the recommended media specification for this product unless it is HP paper that has been approved for use in this product.</td>
</tr>
<tr>
<td>Glossy or coated paper</td>
<td>• Use only glossy or coated paper that is approved for use in laser printers.</td>
<td>• Do not use glossy or coated paper designed for use in inkjet products.</td>
</tr>
</tbody>
</table>

Change the printer driver to match the paper type and size in Windows

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab.
4. Select a size from the **Paper size** drop-down list.
5. Select a paper type from the **Paper type** drop-down list.
6. Click the **OK** button.
**Supported paper sizes**

To obtain best print results, select the appropriate paper size and type in your print driver before printing.

**Table 6-1  Supported paper and print media sizes**

<table>
<thead>
<tr>
<th>Size</th>
<th>Dimensions</th>
<th>Tray 1</th>
<th>Tray 2 or optional Tray 3</th>
<th>Automatic duplex printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter</td>
<td>216 x 279 mm (8.5 x 11 inches)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Legal</td>
<td>216 x 356 mm (8.5 x 14 inches)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>A4</td>
<td>210 x 297 mm (8.27 x 11.69 inches)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Executive</td>
<td>184 x 267 mm (7.24 x 10.51 inches)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>A5</td>
<td>148 x 210 mm (5.83 x 8.27 inches)</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A6</td>
<td>105 x 148 mm (4.13 x 5.83 inches)</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B5 (JIS)</td>
<td>182 x 257 mm (7.17 x 10.12 inches)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>16k</td>
<td>184 x 260 mm (7.24 x 10.23 inches)</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>195 x 270 mm (7.68 x 10.62 inches)</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>197 x 273 mm (7.75 x 10.75 inches)</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.5 x 13</td>
<td>216 x 330 mm (8.5 x 13 inches)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>4 x 6</td>
<td>107 x 152 mm (4 x 6 inches)</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5 x 8</td>
<td>127 x 203 mm (5 x 8 inches)</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 x 15 cm</td>
<td>100 x 150 mm (3.9 x 5.9 inches)</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom</td>
<td>Minimum: 76 x 127 mm (3 x 5 in)</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Maximum: 216 x 356 mm (8.5 x 14 in)</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom</td>
<td>Minimum: 102 x 153 mm (4 x 6 in)</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Maximum: 216 x 356 mm (8.5 x 14 in)</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 6-2  Supported envelopes and postcards**

<table>
<thead>
<tr>
<th>Size</th>
<th>Dimensions</th>
<th>Tray 1</th>
<th>Tray 2</th>
<th>Automatic duplex printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelope #10</td>
<td>105 x 241 mm (4.13 x 9.49 inches)</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Envelope DL</td>
<td>110 x 220 mm (4.33 x 8.66 inches)</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Envelope C5</td>
<td>162 x 229 mm (6.93 x 9.84 inches)</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td>Dimensions</td>
<td>Tray 1</td>
<td>Tray 2</td>
<td>Automatic duplex printing</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------</td>
<td>--------</td>
<td>--------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Envelope B5</td>
<td>176 x 250 mm (6.7 x 9.8 inches)</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Envelope Monarch</td>
<td>98 x 191 mm (3.9 x 7.5 inches)</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Postcard</td>
<td>100 x 148 mm (3.94 x 5.83 inches)</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Double postcard</td>
<td>148 x 200 mm (5.83 x 7.87 inches)</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
</tbody>
</table>
## Supported paper types and tray capacity

**Table 6-3  Tray 1**

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Weight</th>
<th>Capacity¹</th>
<th>Paper orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Every day:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Plain</td>
<td>60 to 90 g/m² (16 to 24 lb)</td>
<td>Up to 50 sheets</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>• Light</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Bond</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Recycled</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Presentation:</td>
<td>Up to 176 g/m² (47 lb)²</td>
<td>Up to 5 mm (0.2 in) stack height</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>• Matte paper, mid-weight to heavy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Glossy paper, mid-weight to heavy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Brochure:</td>
<td>Up to 176 g/m² (47 lb)²</td>
<td>Up to 5 mm (0.2 in) stack height</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>• Matte paper, mid-weight to heavy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Glossy paper, mid-weight to heavy</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Photo/cover</td>
<td>Up to 176 g/m² (47 lb)²</td>
<td>Up to 5 mm (0.2 in) stack height</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>• Matte cover paper</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Glossy cover paper</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Matte photo paper</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Glossy photo paper</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Postcard</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Cardstock</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 6-3  Tray 1 (continued)

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Weight</th>
<th>Capacity¹</th>
<th>Paper orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other:</td>
<td></td>
<td>Up to 50 sheets, or 10 envelopes</td>
<td>Side to be printed on face-up, with the top edge toward the product</td>
</tr>
<tr>
<td>• Color laser transparency³</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Labels³</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Letterhead</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Envelope¹</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Preprinted</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Prepunched</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Colored</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Rough</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Tough³</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

¹ Capacity can vary depending on paper weight and thickness, and environmental conditions.

² The product supports up to 220 g/m² (59 lb) for glossy, glossy photo paper, and postcards.

³ The product supports 60-160 g/m² (16-42 lb) paper weight for automatic duplex printing.

⁴ This paper type is not supported for automatic duplex printing.

Table 6-4  Tray 2 and Tray 3

<table>
<thead>
<tr>
<th>Media type</th>
<th>Weight</th>
<th>Capacity¹</th>
<th>Paper orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Every day:</td>
<td>60 to 90 g/m² (16 to 24 lb)</td>
<td>Up to 250 sheets</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>• Plain</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Light</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Bond</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Recycled</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Presentation:     | Up to 163 g/m² (43 lb)³ | Up to 12.5 mm (0.5 in) stack height | Side to be printed on face-up, with the top edge at the back of the tray |
| • Matte paper, mid-weight to heavy | | | |
| • Glossy paper, mid-weight to heavy | | | |

| Brochure:         | Up to 163 g/m² (43 lb)³ | Up to 12.5 mm (0.5 in) stack height | Side to be printed on face-up, with the top edge at the back of the tray |
| • Matte paper, mid-weight to heavy | | | |
| • Glossy paper, mid-weight to heavy | | | |
### Table 6-4  Tray 2 and Tray 3 (continued)

<table>
<thead>
<tr>
<th>Media type</th>
<th>Weight</th>
<th>Capacity</th>
<th>Paper orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo/cover</td>
<td>Up to 163 g/m² (43 lb)²</td>
<td>Up to 12.5 mm (0.5 in) stack height</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>Matte cover paper</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Glossy cover paper</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Matte photo paper</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Glossy photo paper</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Postcard</td>
<td>Postcard: Up to 176 g/m² (47 lb)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cardstock</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color laser transparency³</td>
<td>Up to 50 sheets, or 10 envelopes</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray or the stamp-end at the back of the tray</td>
<td></td>
</tr>
<tr>
<td>Labels³</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Letterhead</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope³</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preprinted</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prepunched</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Colored</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rough</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tough³</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

1 Capacity can vary depending on paper weight and thickness, and environmental conditions.
2 The product supports 60-160 g/m² (16-42 lb) paper weight for automatic duplex printing.
3 This paper type is not supported for automatic duplex printing.
Load paper trays

Load Tray 1

1. Open Tray 1.

2. Pull out the extension tray.

3. If you are loading long sheets of paper, flip out the extension.

4. Extend the paper guides fully (callout 1) and then load the paper stack into Tray 1 (callout 2). Adjust the paper guides to the size of the paper.

   NOTE: Place the paper into Tray 1 with the side to be printed on face-up and the top toward the product.
Load Tray 2 or optional Tray 3

1. Pull the tray out of the product.

2. Slide open the paper length and width guides.

3. To load Legal-size paper, extend the tray by pressing and holding the extension tab while pulling the front of the tray toward you.

   **NOTE:** When it is loaded with Legal-size paper, the tray extends from the front of the product approximately 64 mm (2.5 inches).
4. Place the paper in the tray and make sure that it is flat at all four corners. Slide the side paper width guides so that they align with the paper-size marking in the bottom of the tray. Slide the front paper length guide so that it pushes the stack of paper against the back of the tray.

5. Push down on the paper to make sure that the paper stack is below the paper limit tabs on the side of the tray.

6. Slide the tray into the product.
Configure trays

By default, the product pulls paper from Tray 1. If Tray 1 is empty, the product pulls paper from Tray 2, or Tray 3 if it installed. Configuring the tray on this product changes the heat and speed settings to obtain the best print quality for the type of paper that you are using. If you are using special paper for all or most print jobs on the product, change this default setting on the product.

The following table lists possible ways you can use the tray settings to meet your printing needs.

<table>
<thead>
<tr>
<th>Paper use</th>
<th>Configure the product</th>
<th>Print</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Tray 1 and one other tray with the same paper, and have the product pick paper from one tray if the other one is empty.</td>
<td>Load paper in Tray 1. No configuration is needed, if the default settings for type and size have not been changed.</td>
<td>From the software program, print the job.</td>
</tr>
<tr>
<td>Occasionally use special paper, such as heavy paper or letterhead, from a tray that usually contains plain paper.</td>
<td>Load special paper in Tray 1.</td>
<td>From the software program print dialog, chose the paper type that matches the special paper loaded in the tray before sending the print job.</td>
</tr>
<tr>
<td>Frequently use special paper, such as heavy paper or letterhead, from one tray.</td>
<td>Load special paper in Tray 1, and configure the tray for the paper type.</td>
<td>From the software program print dialog, chose the paper type that matches the special paper loaded in the tray before sending the print job.</td>
</tr>
</tbody>
</table>

Configure trays

1. Make sure the product is turned on.

2. Perform one of the following tasks:
   - **Control panel**: Open the System Setup menu, and open the Paper Setup menu. Select the tray that you want to configure.
   - **Embedded Web server**: Click the Settings tab, and then click Paper Handling in the left panel.

3. Change the desired tray setting, and then press OK or click Apply.
Print cartridges

The information contained herein is subject to change without notice. For the latest User Guide information go to www.hp.com/support/LJColorM351_manuals or www.hp.com/support/LJColorM451_manuals.

- Print cartridge information
- Supplies views
- Manage print cartridges
- Replacement instructions
- Solve problems with supplies
Print cartridge information

<table>
<thead>
<tr>
<th>Color</th>
<th>Cartridge number</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard-capacity replacement black print cartridge</td>
<td>305A</td>
<td>CE410A</td>
</tr>
<tr>
<td>High-capacity replacement black print cartridge</td>
<td>305X</td>
<td>CE410X</td>
</tr>
<tr>
<td>Replacement cyan print cartridge</td>
<td>305A</td>
<td>CE411A</td>
</tr>
<tr>
<td>Replacement yellow print cartridge</td>
<td>305A</td>
<td>CE412A</td>
</tr>
<tr>
<td>Replacement magenta print cartridge</td>
<td>305A</td>
<td>CE413A</td>
</tr>
</tbody>
</table>

Accessibility: The print cartridge can be installed and removed by using one hand.

Environmental features: Recycle print cartridges by using the HP Planet Partners return and recycling program.

For more information about supplies, go to www.hp.com/go/learnaboutsupplies.
Supplies views

Print cartridge views

1 Cartridge memory chip
2 Plastic shield
3 Imaging Drum. Do not touch the imaging drum on the bottom of the print cartridge. Fingerprints on the imaging drum can cause print-quality problems.
Manage print cartridges

Correctly using, storing, and monitoring the print cartridge can help ensure high-quality print output.

Change settings for print cartridges

Print when a print cartridge is at estimated end of life

Supply-related notifications are communicated on the product control panel.

A <Supply> Low message—where <Supply> is the color print cartridge: The product indicates when a supply level is low. Actual cartridge life remaining may vary. Consider having a replacement available to install when print quality is no longer acceptable. The supply does not need to be replaced now.

A <Supply> Very Low message. The product indicates when a supply level is very low. Actual cartridge life remaining may vary. Consider having a replacement available to install when print quality is no longer acceptable. The supply does not need to be replaced now unless the print quality is no longer acceptable. Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has ended.

Print-quality problems can occur when using a print cartridge that is at its estimated end of life. The supply does not need to be replaced at this point in time unless the print quality is no longer acceptable.

**NOTE:** Using the Continue setting allows printing beyond Very Low without customer interaction and can result in unsatisfactory print quality.

Enable or disable the At Very Low settings from the control panel

You can enable or disable the default setting at any time, and you do not have to re-enable it when you install a new print cartridge.

1. At the control panel, press the OK button to open the menus.

2. Open the following menus:
   - System Setup
   - Supply Settings
   - Black Cartridge or Color Cartridges
   - Very Low Setting

3. Select one of the following options.
   - Select the Continue option to set the product to alert you that the print cartridge is very low, but to continue printing.
   - Select the Stop option to set the product to stop printing until you replace the print cartridge.
Select the **Prompt** option to set the product to stop printing and prompt you to replace the print cartridge. You can acknowledge the prompt and continue printing. A customer configurable option on this product is "Prompt to Remind Me in 100 pages, 200 pages, 300 pages, or never." This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.

- On the **Color Cartridges** menu only, select **Print Black** to alert you when the print cartridge is very low, but to continue printing in black only.

Once an HP supply has reached **very low**, HP’s premium Protection Warranty on that supply has ended.

**Print with EconoMode**

EconoMode uses less toner, which might extend the life of the print cartridge.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might outlast the mechanical parts in the print cartridge. If print quality begins to degrade and is no longer acceptable, consider replacing the print cartridge.

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab.
4. Click the **EconoMode** check box.

**Store and recycle supplies**

**Recycle supplies**

To recycle a genuine HP print cartridge, place the used cartridge in the box in which the new cartridge arrived. Use the enclosed return label to send the used supply to HP for recycling. For complete information, see the recycling guide that is included with each new HP supply item.

**Print-cartridge storage**

Do not remove the print cartridge from its package until you are ready to use it.

⚠️ **CAUTION:** To prevent damage to the print cartridge, do not expose it to light for more than a few minutes.

**HP policy on non-HP print cartridges**

Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new or remanufactured.

_embeddings:NOTE:_ Any damage caused by a non-HP print cartridge is not covered under the HP warranty and service agreements.
HP anticounterfeit Web site

Go to [www.hp.com/go/anticounterfeit](http://www.hp.com/go/anticounterfeit) when you install an HP print cartridge and the control-panel message says the cartridge is non-HP. HP will help determine if the cartridge is genuine and take steps to resolve the problem.

Your print cartridge might not be a genuine HP print cartridge if you notice the following:

- The supplies status page indicates that a non-HP supply is installed.
- You are experiencing a high number of problems with the print cartridge.
- The cartridge does not look like it usually does (for example, the packaging differs from HP packaging).
Replacement instructions

Replace the print cartridges

The product uses four colors and has a different print cartridge for each color: black (K), magenta (M), cyan (C), and yellow (Y).

⚠️ CAUTION: If toner gets on any clothing, wipe it off with a dry cloth and wash the clothing in cold water. Hot water sets toner into the fabric.

1. Open the front door.

2. Pull out the print-cartridge drawer.

3. Grasp the handle on the old print cartridge and then pull the cartridge straight up to remove it.
4. Remove the new print cartridge from the packaging.

5. Gently rock the print cartridge from front to back to distribute the toner evenly inside the cartridge.

6. Remove the orange, plastic shield from the bottom of the new print cartridge.
7. Do not touch the imaging drum on the bottom of the print cartridge. Fingerprints on the imaging drum can cause print-quality problems.

8. Insert the new print cartridge into the product.

9. Pull the tab on the left side of the print cartridge straight up to completely remove the sealing tape. Recycle the sealing tape.
10. Close the print-cartridge drawer.

11. Close the front door.

12. Place the old print cartridge, the sealing tape, and the orange plastic shield in the box for the new print cartridge. Follow the recycling instructions that are included in the box.
Solve problems with supplies

Check the print cartridges

Check each print cartridge, and replace it if necessary, if you are having any of the following problems:

- The printing is too light or seems faded in areas.
- Printed pages have small unprinted areas.
- Printed pages have streaks or bands.

**NOTE:** If you are using a draft print setting, the printing might appear light.

If you determine that you need to replace a print cartridge, print the Supplies Status Page to find the part number for the correct genuine HP print cartridge.

<table>
<thead>
<tr>
<th>Type of print cartridge</th>
<th>Steps to resolve the problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refilled or remanufactured print cartridge</td>
<td>Hewlett Packard Company cannot recommend the use of non-HP supplies, either new or remanufactured. Because they are not HP products, HP cannot influence their design or control their quality. If you are using a refilled or remanufactured print cartridge and are not satisfied with the print quality, replace the cartridge with a genuine HP cartridge.</td>
</tr>
<tr>
<td>Genuine HP print cartridge</td>
<td>1. The product control panel or the <strong>Supplies Status</strong> page indicates <strong>Very Low</strong> status when the cartridge has reached the end of its estimated life. Replace the print cartridge if print quality is no longer acceptable.</td>
</tr>
<tr>
<td></td>
<td>2. Print a Print Quality Page from the <strong>Reports</strong> menu on the control panel. If streaks or marks are in one color on the page, you might have a defect in that color cartridge. See the instructions in this document for interpreting the page. Replace the print cartridge if necessary.</td>
</tr>
<tr>
<td></td>
<td>3. Visually inspect the print cartridge for damage. See the instructions that follow. Replace the print cartridge if necessary.</td>
</tr>
<tr>
<td></td>
<td>4. If printed pages have marks that repeat several times at the same distance apart, print a cleaning page. If this does not solve the problem, use the repetitive defects ruler in this document to identify the cause of the problem.</td>
</tr>
</tbody>
</table>
Print the Supplies Status page

The **Supplies Status** page indicates the estimated life remaining in print cartridges. It also lists the part number for the correct genuine HP print cartridge for your product so you can order a replacement print cartridge, as well as other useful information.

1. At the control panel, press the **OK** button to open the menus.
2. Open the following menus:
   - **Reports**
   - **Supplies Status**
Interpret the Print Quality Page

1. On the product control panel, open the Reports menu.
2. Select the Print Quality Page item to print it.

This page contains five bands of color, which are divided into four groups as indicated in the following illustration. By examining each group, you can isolate the problem to a particular print cartridge.

<table>
<thead>
<tr>
<th>Section</th>
<th>Print-cartridge</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Yellow</td>
</tr>
<tr>
<td>2</td>
<td>Cyan</td>
</tr>
<tr>
<td>3</td>
<td>Black</td>
</tr>
<tr>
<td>4</td>
<td>Magenta</td>
</tr>
</tbody>
</table>

- If dots or streaks appear in only one of the groups, replace the print cartridge that correlates with that group.
- If dots appear in more than one group, print a cleaning page. If this does not solve the problem, determine if the dots are always the same color; for example, if magenta dots appear in all five color bands. If the dots are all the same color, replace that print cartridge.
- If streaks appear in multiple color bands, contact HP. A component other than the print cartridge is probably causing the problem.

Inspect the print cartridge for damage

1. Remove the print cartridge from the product, and verify that the sealing tape has been removed.
2. Check the memory chip for damage.
3. Examine the surface of the green imaging drum on the bottom of the print cartridge.

⚠️ **CAUTION:** Do not touch the green roller (imaging drum) on the bottom of the cartridge. Fingerprints on the imaging drum can cause print-quality problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the print cartridge.

5. If the imaging drum does not appear to be damaged, rock the print cartridge gently several times and reinstall it. Print a few pages to see if the problem has resolved.

**Repeating defects**

If defects repeat at any of the following intervals on the page, a print cartridge might be damaged.

- 22 mm
- 27 mm
- 28 mm
- 75 mm
Interpret control panel messages for supplies

10.XXXX Supply error

Description
The memory chip for one of the print cartridges cannot be read or is missing.
- 10.0000 = black memory chip error
- 10.0001 = cyan memory chip error
- 10.0002 = magenta memory chip error
- 10.0003 = yellow memory chip error
- 10.1000 = black memory chip is missing
- 10.1001 = cyan memory chip is missing
- 10.1002 = magenta memory chip is missing
- 10.1003 = yellow memory chip is missing

Recommended action
Reinstall the print cartridge.

Turn the product off and then on.

If the problem is not solved, replace the print cartridge.

Black cartridge low

Description
The print cartridge is nearing the end of its useful life.

Recommended action
Printing can continue, but consider having a replacement supply on hand.

Black in wrong position

Description
The print cartridge is installed in the incorrect slot.

Recommended action
Make sure that each print cartridge is installed in the correct slot. From front to back, the print cartridges are installed in this order: black, cyan, magenta, and yellow.
**Black very low**

**Description**

The print cartridge is at the end of its useful life. A customer configurable option on this product is "Prompt to Remind Me in 100 pages, 200 pages, 300 pages, or never." This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.

**Recommended action**

To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You can continue printing until you notice a decrease in print quality. Actual cartridge life may vary.

Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.

---

**Cyan cartridge low**

**Description**

The print cartridge is nearing the end of its useful life.

**Recommended action**

Printing can continue, but consider having a replacement supply on hand.

---

**Cyan in wrong position**

**Description**

The print cartridge is installed in the incorrect slot.

**Recommended action**

Make sure that each print cartridge is installed in the correct slot. From front to back, the print cartridges are installed in this order: black, cyan, magenta, and yellow.

---

**Cyan very low**

**Description**

The print cartridge is at the end of its useful life. A customer configurable option on this product is "Prompt to Remind Me in 100 pages, 200 pages, 300 pages, or never." This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.

**Recommended action**

To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You can continue printing until you notice a decrease in print quality. Actual cartridge life may vary.

Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.
low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.

**Genuine HP supply installed**

**Description**
A genuine HP supply was installed.

**Recommended action**
No action necessary.

**Incompatible <color>**

**Description**
You have installed a print cartridge that is intended for use in a different HP product model. The product might not function correctly with this print cartridge installed.

**Recommended action**
Install the correct print cartridge for this product.

**Incorrect supplies**

**Description**
More than one print cartridge is installed in the incorrect slot.

**Recommended action**
Be sure that each print cartridge is in the correct slot. From front to back, the print cartridges are installed in this order: black, cyan, magenta, yellow.

**Install <color> cartridge**

**Description**
The print cartridge is either not installed or not correctly installed in the product.

**Recommended action**
Install the print cartridge.

**Magenta cartridge low**

**Description**
The print cartridge is nearing the end of its useful life.

**Recommended action**
Printing can continue, but consider having a replacement supply on hand.
Magenta in wrong position

Description
The print cartridge is installed in the incorrect slot.

Recommended action
Make sure that each print cartridge is installed in the correct slot. From front to back, the print cartridges are installed in this order: black, cyan, magenta, and yellow.

Magenta very low

Description
The print cartridge is at the end of its useful life. A customer configurable option on this product is "Prompt to Remind Me in 100 pages, 200 pages, 300 pages, or never." This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.

Recommended action
To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You can continue printing until you notice a decrease in print quality. Actual cartridge life may vary.

Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.

Remove shipping lock from <color> cartridge

Description
A print cartridge shipping lock is installed.

Recommended action
Pull the orange tab to remove the shipping lock from the cartridge.

Remove shipping locks from cartridges

Description
A print cartridge shipping lock is installed on one or more print cartridges.

Recommended action
Pull the orange tab to remove the shipping lock from the cartridge.
**Replace <color>**

**Description**

The print cartridge is at the end of its useful life, and the product is customer configured to stop printing when it reaches the very low state.

**Recommended action**

To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You can continue printing until you notice a decrease in print quality. Actual cartridge life may vary. Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.

**Supplies low**

**Description**

More than one supply item is low.

**Recommended action**

Check the supply level gauges on the control panel, or print a supplies status page to determine which print cartridges are low.

Printing will continue until a Very Low message displays. Consider having replacement supplies on hand.

**Unsupported <color> Press [OK] to continue**

**Description**

The product has detected a print cartridge that was not made by HP.

**Recommended action**

Press the OK button to continue printing.

If you believe you purchased an HP supply, go to www.hp.com/go/anticounterfeit. Service or repairs that are required as a result of using unsupported supplies is not covered under HP warranty.

**Used <color> in use**

**Description**

You are using a print cartridge that reached the default low threshold while it was installed in a product.

**Recommended action**

Printing can continue, but consider having a replacement supply on hand.
Used <color> installed Press [OK] to continue

Description
You have installed a print cartridge that reached the default low threshold while it was installed in another product.

Recommended action
Press the OK button to continue.

Used supplies in use

Description
You are using more than one print cartridge that reached the default low threshold while it was installed in a product.

Recommended action
Printing can continue, but consider having replacement supplies on hand.

Yellow cartridge low

Description
The print cartridge is nearing the end of its useful life.

Recommended action
Printing can continue, but consider having a replacement supply on hand.

Yellow in wrong position

Description
The print cartridge is installed in the incorrect slot.

Recommended action
Make sure that each print cartridge is installed in the correct slot. From front to back, the print cartridges are installed in this order: black, cyan, magenta, and yellow.

Yellow very low

Description
The print cartridge is at the end of its useful life. A customer configurable option on this product is "Prompt to Remind Me in 100 pages, 200 pages, 300 pages, or never." This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.

Recommended action
To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You can continue printing until you notice a decrease in print quality. Actual cartridge life may vary.
Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.
8 Print tasks

- Cancel a print job
- Basic print tasks with Windows
- Use HP ePrint
- Additional print tasks with Windows
Cancel a print job

1. If the print job is currently printing, cancel it by pressing the Cancel \( \times \) button on the product control panel.

   **NOTE:** Pressing the Cancel \( \times \) button clears the job that the product is currently processing. If more than one process is running, pressing the Cancel \( \times \) button clears the process that currently appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

   - **Software program:** Typically, a dialog box appears briefly on the computer screen, allowing you to cancel the print job.

   - **Print queue:** If a print job is waiting in a print queue (computer memory) or print spooler, delete the job there.

     - **Windows XP, Server 2003, or Server 2008:** Click Start, click Settings, and then click Printers and Faxes. Double-click the product icon to open the window, right-click the print job that you want to cancel, and then click Cancel.

     - **Windows Vista:** Click Start, click Control Panel, and then, under Hardware and Sound, click Printer. Double-click the product icon to open the window, right-click the print job that you want to cancel, and then click Cancel.

     - **Windows 7:** Click Start, and then click Devices and Printers. Double-click the product icon to open the window, right-click the print job that you want to cancel, and then click Cancel.
Basic print tasks with Windows

The methods to open the print dialog from software programs can vary. The procedures that follow include a typical method. Some software programs do not have a File menu. See the documentation for your software program to learn how to open the print dialog.

Open the printer driver with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.
Get help for any printing option with Windows

1. Click the **Help** button to open the online Help.

Change the number of print copies with Windows

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then select the number of copies.

Save custom print settings for reuse with Windows

Use a printing shortcut with Windows

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Printing Shortcuts** tab.

4. Select one of the shortcuts, and then click the **OK** button.

**NOTE:** When you select a shortcut, the corresponding settings change on the other tabs in the printer driver.
Create printing shortcuts

1. On the **File** menu in the software program, click **Print**.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Printing Shortcuts** tab.
4. Select an existing shortcut as a base.

   **NOTE:** Always select a shortcut before adjusting any of the settings on the right side of the screen. If you adjust the settings and then select a shortcut, all your adjustments are lost.

5. Select the print options for the new shortcut.
6. Click the **Save As** button.

7. Type a name for the shortcut, and click the **OK** button.

---

### Improve print quality with Windows

#### Select the page size with Windows

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab.
4. Select a size from the **Paper size** drop-down list.

#### Select a custom page size with Windows

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab.
4. Click the **Custom** button.
5. Type a name for the custom size and specify the dimensions.
   - The width is the short edge of the paper.
   - The length is the long edge of the paper.

**NOTE:** Always load paper into the trays short edge first.

6. Click the OK button, and then click the OK button on the Paper/Quality tab. The custom page size will appear in the list of paper sizes the next time you open the printer driver.

**Select the paper type with Windows**

1. On the File menu in the software program, click Print.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quality tab.
4. From the Paper type drop-down list, click the More... option.
5. Expand the list of Type is: options.
6. Expand the category of paper types that best describes your paper, and then click the paper type that you are using.

**Select the paper tray with Windows**

1. On the File menu in the software program, click Print.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quality tab.
4. Select a tray from the Paper source drop-down list.

**Print on both sides (duplex) with Windows**

**Print on both sides manually with Windows**

1. On the File menu in the software program, click Print.
2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Finishing** tab.

4. Select the **Print on both sides (manually)** check box. Click the **OK** button to print the first side of the job.
5. Retrieve the printed stack from the output bin, and maintaining the same orientation, place it with the printed side facing down in Tray 1.

6. On the control panel, press the OK button to print the second side of the job.

Automatically print on both sides with Windows

1. On the **File** menu in the software program, click **Print**.

2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Finishing** tab.

4. Select the **Print on both sides** check box. Click the **OK** button to print the job.

---

**Print multiple pages per sheet with Windows**

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the Properties or Preferences button.

3. Click the Finishing tab.
4. Select the number of pages per sheet from the **Pages per sheet** drop-down list.

5. Select the correct **Print page borders**, **Page order**, and **Orientation** options.

**Select page orientation with Windows**

1. On the *File* menu in the software program, click *Print*. 
2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Finishing** tab.

4. In the **Orientation** area, select the **Portrait** or **Landscape** option.

   To print the page image upside down, select the **Rotate by 180 degrees** option.
Set color options with Windows

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Color** tab.
4. Click the **HP EasyColor** check box to clear it.
5. In the **Color Options** area, click the **Manual** option, and then click the **Settings** button.
6. Adjust the general settings for Edge Control, and settings for text, graphics, and photographs.
Use HP ePrint

Use HP ePrint to print documents by sending them as an e-mail attachment to the product's e-mail address from any e-mail enabled device.

**NOTE:** The product must be connected to a network and have Internet access to use HP ePrint.

1. To use HP ePrint, you must first enable HP Web Services.
   a. Type the product IP address into the address line of a Web browser to open the HP Embedded Web Server.
   b. Click the **HP Web Services** tab.
   c. Select the option to enable Web Services.

2. Use the HP ePrintCenter Web site to define security settings and to configure default print settings for all HP ePrint jobs sent to this product.
   a. Go to [www.hpeprintcenter.com](http://www.hpeprintcenter.com).
   b. Click **Sign In**, and enter your HP ePrintCenter credentials or sign up for a new account.
   c. Select your product from the list, or click **+ Add printer** to add it. To add the product, you need the printer code, which is the segment of the product e-mail address that is before the @ symbol.

   **NOTE:** This code is valid for only 24 hours from the time you enable HP Web Services. If it expires, follow the instructions to enable HP Web Services again, and obtain a new code.
   
   d. To prevent your product from printing unexpected documents, click **ePrint Settings**, and then click the **Allowed Senders** tab. Click **Allowed Senders Only**, and add the e-mail addresses from which you want to allow ePrint jobs.
   
   e. To set up default settings for all ePrint jobs sent to this product, click **ePrint Settings**, click **Print Options**, and select the settings that you want to use.

3. To print a document, attach it to an e-mail message sent to the product's e-mail address.
Additional print tasks with Windows

Print colored text as black (grayscale) with Windows

1. On the File menu in the software program, click Print.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Advanced tab.
4. Expand the Document Options section.
5. Expand the Printer Features section.
6. In the Print All Text as Black drop-down list, select the Enabled option.

Print on preprinted letterhead or forms with Windows

1. On the File menu in the software program, click Print.
2. Select the product, and then click the Properties or Preferences button.
3. Click the **Paper/Quality** tab.

4. From the **Paper type** drop-down list, click the **More...** option.

5. Expand the list of **Type is:** options.
6. Expand the list of **Other** options.

7. Select the option for the type of paper you are using, and click the **OK** button.

---

**Print on special paper, labels, or transparencies with Windows**

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.
5. Expand the list of **Type is**: options.

6. Expand the category of paper types that best describes your paper.

   **NOTE:** Labels and transparencies are in the list of **Other** options.

7. Select the option for the type of paper you are using, and click the **OK** button.
Print the first or last page on different paper with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.
4. In the Special pages area, click the Print pages on different paper option, and then click the Settings button.

5. In the Pages in document area, select either the First or Last option.

6. Select the correct options from the Paper source and Paper type drop-down lists. Click the Add button.
7. If you are printing both the first and last pages on different paper, repeat steps 5 and 6, selecting the options for the other page.

8. Click the OK button.

Scale a document to fit page size with Windows

1. On the File menu in the software program, click Print.
2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Effects** tab.

4. Select the **Print document on** option, and then select a size from the drop-down list.
Add a watermark to a document with Windows

1. On the File menu in the software program, click Print.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Effects tab.
4. Select a watermark from the Watermarks drop-down list.
   Or, to add a new watermark to the list, click the Edit button. Specify the settings for the watermark, and then click the OK button.
5. To print the watermark on the first page only, select the First page only check box. Otherwise, the watermark is printed on each page.

Create a booklet with Windows

1. On the File menu in the software program, click Print.
2. Select the product, and then click the Properties or Preferences button.
3. Click the **Finishing** tab.

4. Select the **Print on both sides** check box.

5. In the **Booklet layout** drop-down list, click the **Left binding** or **Right binding** option. The **Pages per sheet** option automatically changes to **2 pages per sheet**.
6. Retrieve the printed stack from the output bin, and maintaining the same orientation, place it with the printed side facing down in Tray 2.

7. On the control panel, press the OK button to print the second side of the job.
9 Color

- Adjust color
- Use the HP EasyColor option
- Match colors to your computer screen
Adjust color

Manage color by changing the settings on the Color tab in the printer driver.

Change the color theme for a print job

1. On the File menu in the software program, click Print.
2. Click Properties or Preferences.
3. Click the Color tab.
4. Select a color theme from the Color Themes drop-down list.

- **Default (sRGB)**: This theme sets the product to print RGB data in raw device mode. When using this theme, manage color in the software program or in the operating system for correct rendering.

- **Vivid**: The product increases the color saturation in the midtones. Use this theme when printing business graphics.

- **Photo**: The product interprets RGB color as if it were printed as a photograph using a digital mini lab. The product renders deeper, more saturated colors differently than with the Default (sRGB) theme. Use this theme when printing photos.

- **Photo (Adobe RGB 1998)**: Use this theme with printing digital photos that use the AdobeRGB color space rather than sRGB. Turn off color management in the software program when using this theme.

- **None**: No color theme is used.
Change the color options

Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click the Print item.
2. Click Properties or Preferences.
3. Click the Color tab.
4. Clear the HP EasyColor check box.
5. Click the Automatic or Manual setting.
   - Automatic setting: Select this setting for most color print jobs
   - Manual setting: Select this setting to adjust the color settings independent from other settings.

**NOTE:** Changing color settings manually can impact output. HP recommends that only color graphics experts change these settings.

6. Click the Print in Grayscale option to print a color document in black and shades of gray. Use this option to print color documents for photocopying or faxing. You can also use this option to print draft copies or to save color cartridge life.
7. Click the OK button.

Manual color options

Use manual color options to adjust the Neutral Grays, Halftone, and Edge Control options for text, graphics, and photographs.
### Table 9-1 Manual color options

<table>
<thead>
<tr>
<th>Setting description</th>
<th>Setting options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edge Control</strong></td>
<td></td>
</tr>
</tbody>
</table>
| The **Edge Control** setting determines the rendering of edges. Edge control has two components: adaptive halftoning and trapping. Adaptive halftoning increases edge sharpness. Trapping reduces the effect of color-plane misregistration by overlapping the edges of adjacent objects slightly. | - **Off** turns off both trapping and adaptive halftoning.  
- **Light** sets trapping at a minimal level. Adaptive halftoning is on.  
- **Normal** sets trapping at a medium level. Adaptive halftoning is on.  
- **Maximum** is the most aggressive trapping setting. Adaptive halftoning is on. |
| **Halftone**        |                 |
| **Halftone** options affect color output clarity and resolution. | - **Smooth** provides better results for large, solid-filled print areas and enhances photographs by smoothing color gradations. Select this option when uniform and smooth area fills are important.  
- **Detail** is useful for text and graphics that require sharp distinctions among lines or colors, or images that contain a pattern or a high level of detail. Select this option when sharp edges and small details are important. |
| **Neutral Grays**   |                 |
| The **Neutral Grays** setting determines the method for creating gray colors used in text, graphics, and photographs. | - **Black Only** generates neutral colors (grays and black) by using only black toner. This guarantees neutral colors without a color cast. This setting is best for documents and grayscale viewgraphs.  
- **4-Color** generates neutral colors (grays and black) by combining all four toner colors. This method produces smoother gradients and transitions to other colors, and it produces the darkest black. |
Use the HP EasyColor option

If you are using the HP PCL 6 printer driver for Windows, the HP EasyColor technology automatically improves mixed-content documents that are printed from Microsoft Office programs. This technology scans documents and automatically adjusts photographic images in .JPEG or .PNG format. HP EasyColor technology enhances the entire image at one time, rather than dividing it into several pieces, which results in improved color consistency, sharper details, and faster printing.

If you are using the HP Postscript printer driver for Mac, HP EasyColor technology scans all documents and automatically adjusts all photographic images with the same improved photographic results.

In the following example, the images on the left were created without using the HP EasyColor option. The images on the right show the enhancements that result from using the HP EasyColor option.

The HP EasyColor option is enabled by default in both the HP PCL 6 printer driver and the HP Mac Postscript printer driver, so you do not need to make manual color adjustments. To disable the option so you can manually adjust the color settings, open the Color tab in the Windows driver or the Color/Quality Options tab in the Mac driver, and then click the HP EasyColor check box to clear it.
Match colors to your computer screen

The process of matching printer output color to your computer screen is complex, because printers and computer monitors use different methods of producing color. Monitors display colors by using light pixels that use an RGB (red, green, blue) color process, but printers print colors by using a CMYK (cyan, magenta, yellow, and black) process.

Several factors can influence your ability to match printed colors to those on your monitor:

- Print media
- Printer colorants (inks or toners, for example)
- Printing process (Inkjet, press, or laser technology, for example)
- Overhead lighting
- Personal differences in perception of color
- Software programs
- Printer drivers
- Computer operating systems
- Monitors
- Video cards and drivers
- Operating environment (humidity, for example)

Keep these factors in mind when colors on your screen do not perfectly match your printed colors.

For most users, the best method for matching colors is to print sRGB colors.
10 Manage and maintain

- Print information pages
- Use the HP Embedded Web Server
- Use HP Web Jetadmin software
- Product security features
- Economy settings
- Install memory DIMMs
- Clean the product
- Product updates
Print information pages

Information pages reside within the product memory. These pages help diagnose and solve problems with the product.

**NOTE:** If the product language was not correctly set during installation, you can set the language manually so the information pages print in one of the supported languages. Change the language by using the System Setup menu on the control panel or the embedded Web server.

1. At the control panel, press the OK button to open the menus.
2. Open the Reports menu.
3. Select the report you want to print, and then press the OK button to print the report.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Structure</td>
<td>Prints a map of the control panel-menu layout. The active settings for each menu are listed.</td>
</tr>
<tr>
<td>Config Report</td>
<td>Prints a list of all the product settings. Includes network information when the product is connected to a network.</td>
</tr>
<tr>
<td>Supplies Status</td>
<td>Prints the status for each print cartridge, including the following information:</td>
</tr>
<tr>
<td></td>
<td>• Estimated percentage of cartridge life remaining</td>
</tr>
<tr>
<td></td>
<td>• Approximate pages remaining</td>
</tr>
<tr>
<td></td>
<td>• Part numbers for HP print cartridges</td>
</tr>
<tr>
<td></td>
<td>• Number of pages printed</td>
</tr>
<tr>
<td></td>
<td>• Information about ordering new HP print cartridges and recycling used HP print cartridges</td>
</tr>
<tr>
<td>Network Summary</td>
<td>Prints a list of all product network settings</td>
</tr>
<tr>
<td>Usage Page</td>
<td>Prints a page that lists PCL pages, PCL 6 pages, PS pages, pages that were jammed or mispicked in the product, monochrome (black and white) or color pages; and reports the page count</td>
</tr>
<tr>
<td>PCL Font List</td>
<td>Prints a list of all the PCL fonts that are installed.</td>
</tr>
<tr>
<td>PS Font List</td>
<td>Prints a list of all the PostScript (PS) fonts that are installed.</td>
</tr>
<tr>
<td>PCL6 Font List</td>
<td>Prints a list of all the PCL6 fonts that are installed.</td>
</tr>
<tr>
<td>Color Usage Log</td>
<td>Prints a report that shows the user name, application name, and color usage information on a job-by-job basis</td>
</tr>
<tr>
<td>Service Page</td>
<td>Prints the service report</td>
</tr>
<tr>
<td>Diagnostics Page</td>
<td>Prints the calibration and color diagnostics pages</td>
</tr>
<tr>
<td>Print Quality Page</td>
<td>Prints a page that helps solve problems with print quality</td>
</tr>
</tbody>
</table>
Use the HP Embedded Web Server

This product is equipped with an embedded Web server (EWS), which provides access to information about product and network activities. A Web server provides an environment in which web programs may run, much in the same way that an operating system, such as Windows, provides an environment for programs to run on a computer. The output from these programs can then be displayed by a Web browser, such as Microsoft Internet Explorer, Safari, or Netscape Navigator.

An “embedded” Web server resides on a hardware device (such as an HP LaserJet product) or in firmware, rather than as software that is loaded on a network server.

The advantage of an EWS is that it provides an interface to the product that anyone with a network-connected product and computer can use. There is no special software to install or configure, but you must have a supported Web browser on the computer. To gain access to the EWS, type the IP address for the product in the address line of the browser. To find the IP address, print a configuration page.

**NOTE:** For Macintosh operating systems, you can use the EWS over a USB connection after installing the Macintosh software included with the product.

Open the HP Embedded Web Server

To open the HP Embedded Web Server, type the IP address or host name of the product in the address field of a supported Web browser. To find the IP address or host name, print a configuration page.

You can also open the HP Embedded Web Server from the printer driver. Open the Services tab and click the supplies icon.

**NOTE:** If an error occurs while opening the HP Embedded Web Server, confirm that the proxy settings are correct for your network.

**TIP:** After you open the URL, bookmark it so that you can return to it quickly in the future.

HP Embedded Web Server features

The EWS allows you to view product and network status and manage printing functions from a computer. With the EWS, you can complete the following tasks:

- View product status information
- Enable HP Web Services, including HP ePrint.
- Determine the remaining life on all supplies and order new ones
- View and change part of the product configuration
- View and print some internal pages
- Select the language in which to display the EWS pages and control panel messages
• View and change network configuration
• Set, change, or clear the product security password.

**NOTE:** Changing network settings in the EWS might disable some of product software or features.

### Use HP Web Jetadmin software

HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of networked HP devices, including printers, multifunction products, and digital senders. This single solution allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and imaging environment — ultimately increasing business productivity by helping you save time, control costs, and protect your investment.

HP Web Jetadmin updates are periodically made available to provide support for specific product features. Visit [www.hp.com/go/webjetadmin](http://www.hp.com/go/webjetadmin) and click the **Self Help and Documentation** link to learn more about updates.

### Product security features

The product supports security standards and recommended protocols that help you keep the product secure, protect critical information on your network, and simplify the way you monitor and maintain the product.

For in-depth information about HP's secure imaging and printing solutions, visit [www.hp.com/go/secureprinting](http://www.hp.com/go/secureprinting). The site provides links to white papers and FAQ documents about security features.

### Assign a system password

Assign a password for the product so that unauthorized users cannot change the product settings.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a Web browser.
2. Click the **Settings** tab.
3. On the left side of the window, click the **Security** menu.
4. In the **Device Security Settings** area, click the **Configure . . .** button.
5. In the **Device Password** area, type the password in the **New Password** box, and type it again in the **Verify password** box.
6. Click the **Apply** button. Make note of the password and store it in a safe place.
Economy settings

Print with EconoMode

EconoMode uses less toner, which might extend the life of the print cartridge.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might outlast the mechanical parts in the print cartridge. If print quality begins to degrade and is no longer acceptable, consider replacing the print cartridge.

1. On the File menu in the software program, click Print.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quality tab.
4. Click the EconoMode check box.

Powersave modes

The adjustable sleep mode feature reduces power consumption when the product has been inactive for an extended period. You can set the length of time before the product enters sleep mode.

NOTE: This mode does not affect product warm-up time.

Set sleep delay

1. At the control panel, press the OK button to open the menus.
2. Open the following menus:
   - System Setup
   - Energy Settings
   - Sleep Delay
3. Select the time for the delay, and then press the OK button.

NOTE: The default value is 15 minutes.

Set the Auto Power Down delay

1. At the control panel, press the OK button to open the menus.
2. Open the following menus:
   - System Setup
   - Energy Settings
Auto Power Down

Power Down Delay

3. Select the time for the power-down delay.

NOTE: The default value is 30 minutes.

4. The product automatically wakes from the auto power-down mode when it receives jobs or when you press a button on the control panel. You can change which events cause the product to wake. Open the following menus:

- System Setup
- Energy Settings
- Auto Power Down
- Wake Events

To turn off a wake event, select the event and then select the No option.

Archive print

Archive print produces output that is less susceptible to toner smearing and dusting. Use archive print to create documents that you want to preserve or archive.

1. At the control panel, press the OK button to open the menus.

2. Open the following menus:

- Service
- Archive Print

3. Select the On or Off option, and then press the OK button.
Install memory DIMMs

This product comes with 128-megabyte (MB) random-access memory installed. You can install an additional 256-megabyte of memory for the product by adding a dual inline memory module (DIMM). You can also install a font DIMM to allow the product to print characters (for example, Chinese language or the Cyrillic alphabet characters).

⚠️ CAUTION: Static electricity can damage electronic parts. When handling electronic parts, either wear an antistatic wrist strap, or frequently touch the surface of the antistatic package and then touch bare metal on the product.

Install memory DIMMs

1. Turn the product off, and then disconnect all power and interface cables.
2. On the right side of the product, open the DIMM access door.
3. Remove the DIMM access door.
4. To replace a DIMM that is currently installed, spread the latches apart on each side of the DIMM slot, lift the DIMM up at an angle, and pull it out.

⚠️ **CAUTION:** Static electricity can damage electronic parts. When handling electronic parts, either wear an antistatic wrist strap, or frequently touch the surface of the antistatic package and then touch bare metal on the product.

5. Remove the new DIMM from the antistatic package, and then locate the alignment notch on the bottom edge of the DIMM.
6. Holding the DIMM by the edges, align the notch on the DIMM with the bar in the DIMM slot at an angle.

7. Push down on the DIMM until both latches engage the DIMM. When the installation is correct, the metal contacts are not visible.

**NOTE:** If you have difficulty inserting the DIMM, make sure that the notch on the bottom of the DIMM is aligned with the bar in the slot. If the DIMM still does not go in, make sure that you are using the correct DIMM type.
8. Reinsert the DIMM access door.

9. Close the DIMM access door.

10. Reconnect the power cable and USB or network cable, and then turn on the product.

**Enable memory**

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Click Start.</td>
</tr>
<tr>
<td>2.</td>
<td>Click Settings.</td>
</tr>
<tr>
<td>3.</td>
<td>Click Printers and Faxes (using the default Start menu view) or click Printers (using the Classic Start menu view).</td>
</tr>
<tr>
<td>4.</td>
<td>Right-click the product driver icon, and then select Properties.</td>
</tr>
<tr>
<td>5.</td>
<td>Click the Device Settings tab.</td>
</tr>
<tr>
<td>6.</td>
<td>Expand the area for Installable Options.</td>
</tr>
<tr>
<td>7.</td>
<td>Next to Automatic Configuration, select Update Now.</td>
</tr>
<tr>
<td>8.</td>
<td>Click OK.</td>
</tr>
</tbody>
</table>

**NOTE:** If the memory is not updated correctly after using the Update Now option, you can manually select the total amount of memory installed in the product in the Installable Options area.

The Update Now option overwrites any existing product configuration settings.
### Windows 7

1. Click **Start**.
2. Click **Devices and Printers**.
3. Right-click the product driver icon, and then select **Printer properties**.
4. Click the **Device Settings** tab.
5. Expand the area for **Installable Options**.
6. Next to **Automatic Configuration**, select **Update Now**.
7. Click **OK**.

**NOTE:** If the memory is not updated correctly after using the **Update Now** option, you can manually select the total amount of memory installed in the product in the **Installable Options** area.

The **Update Now** option overwrites any existing product configuration settings.

### Mac OS X 10.5 and 10.6

1. From the Apple menu, click the **System Preferences** menu and then click the **Print & Fax** icon.
2. Select the product in the left side of the window.
3. Click the **Options & Supplies** button.
4. Click the **Driver** tab.
5. Configure the installed options.

---

### Check DIMM installation

After installing the DIMM, make sure that the installation was successful.

1. Turn the product on. Check that the Ready light is illuminated after the product has gone through the startup sequence. If an error message appears, a DIMM might have been incorrectly installed.
2. Print a configuration page.
3. Check the memory section on the configuration page and compare it to the configuration page that was printed before the memory installation. If the amount of memory has not increased, the DIMM might not be installed correctly, or the DIMM might be defective. Repeat the installation procedure. If necessary, install a different DIMM.

**NOTE:** If you installed a product language (personality), check the "Installed Personalities and Options" section on the configuration page. This area should list the new product language.

### Memory allocation

Utilities or jobs that you download to the product sometimes include resources (for example, fonts, macros, or patterns). Resources that are internally marked as permanent remain in the product memory until you turn the product off.
Use the following guidelines if you use the page description language (PDL) ability to mark resources as permanent. For technical details, see an appropriate PDL reference for PCL or PS.

- Mark resources as permanent only when it is absolutely necessary that they remain in memory while the product is turned on.
- Send permanent resources to the product only at the beginning of a print job and not while the product is printing.

**NOTE:** Overusing permanent resources or downloading them while the product is printing might affect product performance or the ability to print complex pages.
Clean the product

During the printing process, paper, toner, and dust particles can accumulate inside the product. Over time, this buildup can cause print-quality problems such as toner specks or smearing. This product has a cleaning mode that can correct and prevent these problems.

1. At the control panel, press the OK button to open the menus.

2. Open the following menus:
   - Service
   - Cleaning Page

3. Load plain paper in Tray 1, and then press the OK button to start the cleaning process. Wait until the process is complete. Discard the page that prints.

   **NOTE:** For models that do not have an automatic duplexer, the product prints the first side and then prompts you to remove the page from the output bin and reload it in Tray 1, keeping the same orientation.

Product updates

Software and firmware updates and installation instructions for this product are available at www.hp.com/support/LJColorM351 or www.hp.com/support/LJColorM451. Click Support & Drivers, click the operating system, and then select the download for the product.
11 Solve problems

- Self help
- Solve general problems checklist
- Restore factory settings
- Interpret control panel messages
- Paper feeds incorrectly or becomes jammed
- Clear jams
- Improve print quality
- The product does not print or it prints slowly
- Solve product connectivity problems
- Solve wireless network problems
- Solve product software problems with Windows
- Solve product software problems with Mac
In addition to the information in this guide, other sources are available that provide helpful information.

<table>
<thead>
<tr>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Help and Learn Center</td>
<td>The HP Help and Learn Center and other documentation are on the CD that came with the product or in the HP Program folder on your computer. The HP Help and Learn Center is a product help tool that provides easy access to product information, HP product web support, troubleshooting, and regulatory and safety information.</td>
</tr>
<tr>
<td>Quick Reference Topics</td>
<td>Several Quick Reference Topics for this product are available at this Web site: <a href="http://www.hp.com/support/LJColorM351">www.hp.com/support/LJColorM351</a> or <a href="http://www.hp.com/support/LJColorM451">www.hp.com/support/LJColorM451</a></td>
</tr>
<tr>
<td></td>
<td>You can print these topics and keep them near the product. They are a handy reference for procedures that you perform frequently.</td>
</tr>
</tbody>
</table>
Solve general problems checklist

1. Make sure that the product is set up correctly.
   a. Press the power button to turn on the product or to deactivate the Auto-Off mode.
   b. Check the power-cable connections.
   c. Make sure that the line voltage is correct for the product power configuration. (See the label that is on the back of the product for voltage requirements.) If you are using a power strip and its voltage is not within specifications, plug the product directly into the wall. If it is already plugged into the wall, try a different outlet.
   d. If none of these measures restores power, contact HP Customer Care.

2. Check the cabling.
   a. Check the cable connection between the product and the computer. Make sure that the connection is secure.
   b. Make sure that the cable itself is not faulty by using a different cable, if possible.
   c. Check the network connection (network models only): Make sure the network light is lit. The network light is next to the network port on the back of the product.
      If the product remains unable to connect to the network, uninstall and then reinstall the product. If the error persists, contact a network administrator.

3. Check to see if any messages appear on the control panel.

4. Make sure that the paper that you are using meets specifications.

5. Make sure that the paper is loaded correctly in the input tray.

6. Make sure that the product software is installed correctly.

7. Verify that you have installed the printer driver for this product, and that you are selecting this product from the list of available printers.

8. Print a configuration page.
   a. If the page does not print, verify that the input tray contains paper and that the paper is properly loaded.
   b. Make sure that the print cartridges are installed correctly.
c. If the page jams in the product, clear the jam.

d. If the print quality is unacceptable, complete the following steps:
   - Verify that the print settings are correct for the paper that you are using.
   - Solve print-quality problems.

9. Print a small document from a different program that has worked in the past. If this solution works, then the problem is with the program you are using. If this solution does not work (the document does not print), complete these steps:
   a. Try printing the job from another computer that has the product software installed.
   b. Check the cable connection. Direct the product to the correct port, or reinstall the software, selecting the connection type that you are using.

**Factors that affect product performance**

Several factors affect the time it takes to print a job:

- The use of special paper (such as transparencies, heavy paper, and custom-size paper)
- Product processing and download time
- The complexity and size of graphics
- The speed of the computer you are using
- The USB or network connection
- The product I/O configuration
Restore factory settings

Restoring the factory-set defaults returns all of the product and network settings to the factory defaults. It will not reset the page count, tray size, or language. To restore the product to the factory-default settings, follow these steps.

⚠ **CAUTION:** Restoring the factory-set defaults returns all of the settings to the factory defaults, and it also deletes any pages that are stored in the memory. The procedure then automatically restarts the product.

1. At the control panel, press the OK button to open the menus.
2. Open the following menus:
   - Service
   - Restore Defaults

   The product automatically restarts.
Interpret control panel messages

Control panel message types

The control panel messages indicate the current product status or situations that might require action.

Alert and warning messages appear temporarily and might require you to acknowledge the message by pressing the OK button to resume or by pressing the Cancel button to cancel the job. With certain warnings, the job might not complete or the print quality might be affected. If the alert or warning message is related to printing and the auto-continue feature is on, the product will attempt to resume the printing job after the warning has appeared for 10 seconds without acknowledgement.

Critical error messages can indicate some kind of failure. Turning off and then turning on the power might fix the problem. If a critical error persists, the product might require service.

Control panel messages

10.XXXX Supply error

Description
The memory chip for one of the print cartridges cannot be read or is missing.

- 10.0000 = black memory chip error
- 10.0001 = cyan memory chip error
- 10.0002 = magenta memory chip error
- 10.0003 = yellow memory chip error
- 10.1000 = black memory chip is missing
- 10.1001 = cyan memory chip is missing
- 10.1002 = magenta memory chip is missing
- 10.1003 = yellow memory chip is missing

Recommended action
Reinstall the print cartridge.

Turn the product off and then on.

If the problem is not solved, replace the print cartridge.

49 Error Turn off then on

Description
The product experienced an internal error.
Recommended action

Turn the product off, wait at least 30 seconds, and then turn the product on and wait for it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product power on.

If the message persists, contact HP support.

50.X Fuser error Turn off then on

Description
The product has experienced an error with the fuser.

Recommended action
Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for it to initialize.

Turn off the product, wait at least 25 minutes, and then turn on the product.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product power on.

If the message persists, contact HP support.

51.XX Error Turn off then on

Description
The product has experienced an internal hardware error.

Recommended action
Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product on.

If the message persists, contact HP support.

54.XX Error Turn off then on

Description
The product has experienced an error with one of the internal sensors.

Recommended action
Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product power on.
If the message persists, contact HP support.

55.X Error Turn off then on

Description
The product has experienced an internal error.

Recommended action
Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product power on.

If the message persists, contact HP support.

57 Fan error Turn off then on

Description
The product has experienced a problem with its internal fan.

Recommended action
Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product power on.

If the message persists, contact HP support.

59.X Error Turn off then on

Description
The product has experienced a problem with one of the motors.

Recommended action
Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product power on.

If the message persists, contact HP support.

79 Error Turn off then on

Description
The product has experienced an internal firmware error.
Recommended action

Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product power on.

If the message persists, contact HP support.

79 Service error Turn off then on

Description
An incompatible DIMM is installed.

Recommended action
1. Turn the product power off.
2. Install a DIMM that the product supports.
3. Turn the product on.

If the message persists, contact HP support.

Black cartridge low

Description
The print cartridge is nearing the end of its useful life.

Recommended action
Printing can continue, but consider having a replacement supply on hand.

Black in wrong position

Description
The print cartridge is installed in the incorrect slot.

Recommended action
Make sure that each print cartridge is installed in the correct slot. From front to back, the print cartridges are installed in this order: black, cyan, magenta, and yellow.

Black very low

Description
The print cartridge is at the end of its useful life. A customer configurable option on this product is "Prompt to Remind Me in 100 pages, 200 pages, 300 pages, or never." This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.
Recommended action

To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You can continue printing until you notice a decrease in print quality. Actual cartridge life may vary.

Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.

Cleaning . . .

Description
The product periodically performs a cleaning procedure to maintain the best print quality.

Recommended action
Wait for the cleaning process to finish.

Cyan cartridge low

Description
The print cartridge is nearing the end of its useful life.

Recommended action
Printing can continue, but consider having a replacement supply on hand.

Cyan in wrong position

Description
The print cartridge is installed in the incorrect slot.

Recommended action
Make sure that each print cartridge is installed in the correct slot. From front to back, the print cartridges are installed in this order: black, cyan, magenta, and yellow.

Cyan very low

Description
The print cartridge is at the end of its useful life. A customer configurable option on this product is "Prompt to Remind Me in 100 pages, 200 pages, 300 pages, or never." This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.

Recommended action
To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You can continue printing until you notice a decrease in print quality. Actual cartridge life may vary.
Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.

**Device error Press [OK]**

**Description**

An internal error occurred.

**Recommended action**

Press the OK button to resume the job.

**Front door open**

**Description**

The product front door is open.

**Recommended action**

Close the door.

**Genuine HP supply installed**

**Description**

A genuine HP supply was installed.

**Recommended action**

No action necessary.

**Incompatible <color>**

**Description**

You have installed a print cartridge that is intended for use in a different HP product model. The product might not function correctly with this print cartridge installed.

**Recommended action**

Install the correct print cartridge for this product.

**Incorrect supplies**

**Description**

More than one print cartridge is installed in the incorrect slot.
Recommended action

Be sure that each print cartridge is in the correct slot. From front to back, the print cartridges are installed in this order: black, cyan, magenta, yellow.

Install <color> cartridge

Description

The print cartridge is either not installed or not correctly installed in the product.

Recommended action

Install the print cartridge.

Invalid driver Press [OK]

Description

You are using an incorrect printer driver.

Recommended action

Select the correct printer driver.

Jam in <location>

Description

The product has detected a jam.

Recommended action

Clear the jam from the location indicated. The job should continue to print. If it does not, try reprinting the job.

If the message persists, contact HP support.

Jam in tray # Clear jam and then Press [OK]

Description

The product has detected a jam.

Recommended action

Clear the jam from the location indicated, and then press OK.

If the message persists, contact HP support.

Load tray # <TYPE> <SIZE>

Description

A tray is configured for the paper type and size that the print job is requesting, but that tray is empty.
Recommended action
Load the correct paper into the tray, or press the OK button to use paper in a different tray.

Load tray 1 plain <SIZE> Cleaning Mode [OK] to start

Description
The product is ready to process the cleaning operation.

Recommended action
Load Tray 1 with plain paper in the size indicated, and then press the OK button.

Load tray <X> Press [OK] for available media

Description
The tray is empty.

Recommended action
Load paper into the tray to continue printing. Press the OK button to select a different tray.

Load tray 1 <TYPE> <SIZE>

Description
No trays are configured for the paper type and size that the print job is requesting.

Recommended action
Load the correct paper into Tray 1, or press OK to use paper in a different tray.

Magenta cartridge low

Description
The print cartridge is nearing the end of its useful life.

Recommended action
Printing can continue, but consider having a replacement supply on hand.

Magenta in wrong position

Description
The print cartridge is installed in the incorrect slot.

Recommended action
Make sure that each print cartridge is installed in the correct slot. From front to back, the print cartridges are installed in this order: black, cyan, magenta, and yellow.
Magenta very low

Description
The print cartridge is at the end of its useful life. A customer configurable option on this product is "Prompt to Remind Me in 100 pages, 200 pages, 300 pages, or never." This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.

Recommended action
To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You can continue printing until you notice a decrease in print quality. Actual cartridge life may vary.

Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.

Manual duplex Load tray <X> Press [OK]

Description
The first side of a manual duplex job has printed, and the page needs to be loaded to process the second side.

Recommended action
Load the page in the indicated tray with the side to be printed face up, and the top of the page away from you and then press the OK button.

Manual feed <TYPE> <SIZE> Press [OK] for available media

Description
The product is set for manual feed mode.

Recommended action
Press the OK button to clear the message or load the correct paper into Tray 1.

Memory is low Press [OK]

Description
The product memory is almost full.

Recommended action
Press the OK button to finish the job, or press the Cancel button to cancel the job.

Break the job into smaller jobs that contain fewer pages.
**Misprint Press [OK]**

**Description**

Paper has been delayed as it moves through the product.

**Recommended action**

Press the OK button to clear the message.

To avoid this problem, try the following solutions:

1. Adjust the paper guides in the tray. Make sure the front paper guide is pushing the paper against the back edge of the tray.
2. Use paper that meets HP specifications. Store paper unopened in its original packaging.
3. Use the product in an area that meets the environmental specifications for this product.

**Print failure, press OK. If error repeats, turn off then on.**

**Description**

The product cannot process the page.

**Recommended action**

Press the OK button to continue printing the job, but output might be affected.

If the error persists, turn the power off and then on. Resend the print job.

**Rear door open**

**Description**

The product rear door is open.

**Recommended action**

Close the door.

**Remove shipping lock from <color> cartridge**

**Description**

A print cartridge shipping lock is installed.

**Recommended action**

Pull the orange tab to remove the shipping lock from the cartridge.

**Remove shipping locks from cartridges**

**Description**

A print cartridge shipping lock is installed on one or more print cartridges.
Recommended action

Pull the orange tab to remove the shipping lock from the cartridge.

Replace <color>

Description

The print cartridge is at the end of its useful life, and the product is customer-configured to stop printing when it reaches the very low state.

Recommended action

To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You can continue printing until you notice a decrease in print quality. Actual cartridge life may vary. Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.

Supplies low

Description

More than one supply item is low.

Recommended action

Check the supply level gauges on the control panel, or print a supplies status page to determine which print cartridges are low.

Printing will continue until a Very Low message displays. Consider having replacement supplies on hand.

Unexpected size in tray # Load <size> Press [OK]

Description

The product has detected paper in the tray that does not match the configuration for the tray.

Recommended action

Load the correct paper into the tray, or configure the tray for the size that you have loaded.

Unsupported <color> Press [OK] to continue

Description

The product has detected a print cartridge that was not made by HP.

Recommended action

Press the OK button to continue printing.
If you believe you purchased an HP supply, go to [www.hp.com/go/anticounterfeit](http://www.hp.com/go/anticounterfeit). Service or repairs that are required as a result of using unsupported supplies is not covered under HP warranty.

**Used <color> in use**

**Description**
You are using a print cartridge that reached the default low threshold while it was installed in a product.

**Recommended action**
Prining can continue, but consider having a replacement supply on hand.

**Used <color> installed Press [OK] to continue**

**Description**
You have installed a print cartridge that reached the default low threshold while it was installed in another product.

**Recommended action**
Press the OK button to continue.

**Used supplies in use**

**Description**
You are using more than one print cartridge that reached the default low threshold while it was installed in a product.

**Recommended action**
Printing can continue, but consider having replacement supplies on hand.

**Yellow cartridge low**

**Description**
The print cartridge is nearing the end of its useful life.

**Recommended action**
Printing can continue, but consider having a replacement supply on hand.

**Yellow in wrong position**

**Description**
The print cartridge is installed in the incorrect slot.
**Recommended action**

Make sure that each print cartridge is installed in the correct slot. From front to back, the print cartridges are installed in this order: black, cyan, magenta, and yellow.

**Yellow very low**

**Description**

The print cartridge is at the end of its useful life. A customer configurable option on this product is "Prompt to Remind Me in 100 pages, 200 pages, 300 pages, or never." This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.

**Recommended action**

To ensure optimal print quality, HP recommends replacing the print cartridge at this point. You can continue printing until you notice a decrease in print quality. Actual cartridge life may vary.

Once an HP supply has reached very low, HP's premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.
Paper feeds incorrectly or becomes jammed

- The product does not pick up paper
- The product picks up multiple sheets of paper
- Prevent paper jams

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.
2. Load the tray with the correct size of paper for your job.
3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Align the guides with the paper-size markings in the bottom of the tray.
4. Check the product control panel to see if the product is waiting for you to acknowledge a prompt to feed the paper manually. Load paper, and continue.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the paper. Return the stack of paper to the tray.
2. Use only paper that meets HP specifications for this product.
3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.
4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the stack, and then return some of the paper to the tray.
5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Align the guides with the paper-size markings in the bottom of the tray.

Prevent paper jams

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.
2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.
3. Use paper that has not previously been printed or copied on.
4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the stack, and then return some of the paper to the tray.
5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so they are touching the paper stack without bending it.

6. Make sure that the tray is fully inserted in the product.

7. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and feed sheets one at a time.
Clear jams

Jam locations

Use this illustration to find the locations of jams.

1. Output bin
2. Tray 1
3. Tray 2
4. Fuser
5. Tray 2 jam-access area
Clear jams in Tray 1

1. Pull the jammed sheet from Tray 1.
   
   **NOTE:** If the sheet tears, make sure that all of the fragments are removed before you resume printing.

2. Pull out Tray 2 and place it on a flat surface.

3. Lower the jam-access tray.
4. Remove the jammed sheet by pulling it straight out.

5. Push the jam-access tray up to close it, and then replace Tray 2.

   **NOTE:** To close the tray, push in the middle or with even pressure on both sides. Avoid pushing on one side only.

---

**Clear jams in Tray 2**

1. Open Tray 2.
2. Remove the jammed sheet by pulling it straight out.

3. Close Tray 2.
   
   **NOTE:** To close the tray, push in the middle or with even pressure on both sides. Avoid pushing on one side only.

---

**Clear jams in the fuser area**

1. Open the rear door.

   **CAUTION:** The fuser, located in the back of the product, is hot. Wait for the fuser to cool before continuing.
2. If necessary, push the guide (callout 1) and remove any visible paper (callout 2) from the bottom of the delivery area.

**NOTE:** If the sheet tears, make sure that all fragments are removed before you resume printing. Do not use sharp objects to remove fragments.

3. Close the rear door.
Clear jams in the output bin

1. Look for jammed paper in the output bin area.
2. Remove any visible media.
   **NOTE:** If the sheet tears, make sure that all fragments are removed before resuming printing.

3. Open and then close the rear door to clear the message.

Clear jams in the duplexer (duplexing models only)

1. Open the rear door.
   **CAUTION:** The fuser, located in the back of the product, is hot. Wait for the fuser to cool before continuing.
2. If necessary, pull the guide (callout 1) and remove any visible paper (callout 2) from the bottom of the delivery area.

3. If necessary, remove any visible paper from bottom side of the duplexing unit.

4. If you can not see any jammed paper, lift the duplexing unit using the tab on the side of the duplexing unit.

5. If you can see the trailing edge of the paper, remove the paper from the product.
6. If you can see the leading edge of the paper, remove it from the product.

7. Close the rear door.
Improve print quality

You can prevent most print-quality problems by following these guidelines.

- Use the correct paper type setting in the printer driver
- Adjust color settings in the printer driver
- Use paper that meets HP specifications
- Print a cleaning page
- Calibrate the product to align the colors
- Check the print cartridges
- Use the printer driver that best meets your printing needs

Use the correct paper type setting in the printer driver

Check the paper type setting if you are having any of the following problems:

- Toner is smearing on the printed pages.
- Repeated marks occur on the printed pages.
- Printed pages are curled.
- Toner flakes off the printed pages.
- Printed pages have small unprinted areas.

Change the paper type setting for Windows

1. On the File menu in the software program, click Print.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quality tab.
4. From the Paper type drop-down list, click the More... option.
5. Expand the list of Type is: options.
6. Expand each category of paper types until you find the paper type that you are using.
7. Select the option for the type of paper you are using, and click the OK button.

Change the paper type setting for Mac

1. On the File menu in the software program, click the Print option.
2. In the Copies & Pages menu, click the Page Setup button.
3. Select a size from the Paper Size drop-down list, and then click the OK button.
4. Open the **Finishing** menu.

5. Select a type from the **Media-type** drop-down list.

6. Click the **Print** button.

### Adjust color settings in the printer driver

#### Change the color theme for a print job

1. On the **File** menu in the software program, click **Print**.

2. Click **Properties** or **Preferences**.

3. Click the **Color** tab.

4. Select a color theme from the **Color Themes** drop-down list.

- **Default (sRGB):** This theme sets the product to print RGB data in raw device mode. When using this theme, manage color in the software program or in the operating system for correct rendering.

- **Vivid:** The product increases the color saturation in the midtones. Use this theme when printing business graphics.

- **Photo:** The product interprets RGB color as if it were printed as a photograph using a digital mini lab. The product renders deeper, more saturated colors differently than with the Default (sRGB) theme. Use this theme when printing photos.

- **Photo (Adobe RGB 1998):** Use this theme with printing digital photos that use the AdobeRGB color space rather than sRGB. Turn off color management in the software program when using this theme.

- **None**
Change the color options

Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click Print.
2. Click Properties or Preferences.
3. Click the Color tab.
4. Click the Automatic or Manual setting.
   - Automatic setting: Select this setting for most color print jobs
   - Manual setting: Select this setting to adjust the color settings independent from other settings.

   **NOTE:** Changing color settings manually can impact output. HP recommends that only color graphics experts change these settings.

5. Click the Print in Grayscale option to print a color document in black and white. Use this option to print color documents for photocopying or faxing.
6. Click the OK button.

Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

- The printing is too light or seems faded in areas.
- Specks of toner are on the printed pages.
- Toner is smearing on the printed pages.
- Printed characters seem misformed.
- Printed pages are curled.
Always use a paper type and weight that this product supports. In addition, follow these guidelines when selecting paper:

- Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles, voids, staples, and curled or bent edges.
- Use paper that has not been previously printed on.
- Use paper that is designed for use in laser printers. Do not use paper that is designed only for use in Inkjet printers.
- Use paper that is not too rough. Using smoother paper generally results in better print quality.

**Print a cleaning page**

Print a cleaning page to remove dust and excess toner from the paper path if you are having any of the following problems:

- Specks of toner are on the printed pages.
- Toner is smearing on the printed pages.
- Repeated marks occur on the printed pages.

Use the following procedure to print a cleaning page.

1. At the control panel, press the OK button to open the menus.
2. Open the following menus:
   - Service
   - Cleaning Page
3. Load plain paper in Tray 1, and then press the OK button to start the cleaning process. Wait until the process is complete. Discard the page that prints.

**NOTE:** For models that do not have an automatic duplexer, the product prints the first side and then prompts you to remove the page from the output bin and reload it in Tray 1, keeping the same orientation.

**Calibrate the product to align the colors**

If the printed output has colored shadows, blurry graphics, or areas that have poor color, you might need to calibrate the product to align the colors. Print the **Diagnostics Page** from the **Reports** menu on the control panel to check the color alignment. If the blocks of color on that page are not aligned with each other, you need to calibrate the product.

1. At the control panel, press the OK button to open the menus.
2. Open the following menus:
   - Calibrate Color
   - Calibrate Now
Check the print cartridges

Check each print cartridge, and replace it if necessary, if you are having any of the following problems:

- The printing is too light or seems faded in areas.
- Printed pages have small unprinted areas.
- Printed pages have streaks or bands.

If you determine that you need to replace a print cartridge, print the Supplies Status Page to find the part number for the correct genuine HP print cartridge.

<table>
<thead>
<tr>
<th>Type of print cartridge</th>
<th>Steps to resolve the problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refilled or remanufactured print cartridge</td>
<td>Hewlett Packard Company cannot recommend the use of non-HP supplies, either new or remanufactured. Because they are not HP products, HP cannot influence their design or control their quality. If you are using a refilled or remanufactured print cartridge and are not satisfied with the print quality, replace the print cartridge with a genuine HP print cartridge.</td>
</tr>
<tr>
<td>Genuine HP print cartridge</td>
<td>1. The product control panel or the Supplies Status page indicates Very Low status when the print cartridge has reached the end of its estimated life. Replace the print cartridge if print quality is no longer acceptable.</td>
</tr>
<tr>
<td></td>
<td>2. Print a Print Quality Page from the Reports menu on the control panel. If streaks or marks are in one color on the page, you might have a defect in that color cartridge. See the instructions in this document for interpreting the page. Replace the print cartridge if necessary.</td>
</tr>
<tr>
<td></td>
<td>3. Visually inspect the print cartridge for damage. See the instructions that follow. Replace the print cartridge if necessary.</td>
</tr>
<tr>
<td></td>
<td>4. If printed pages have marks that repeat several times at the same distance apart, print a cleaning page. If this does not solve the problem, use the repetitive defects ruler in this document to identify the cause of the problem.</td>
</tr>
</tbody>
</table>

Print the Supplies Status page

The Supplies Status page indicates the estimated life remaining in print cartridges. It also lists the part number for the correct genuine HP print cartridge for your product so you can order a replacement print cartridge, as well as other useful information.

1. At the control panel, press the OK button to open the menus.

2. Open the following menus:
   - Reports
   - Supplies Status
Interpret the Print Quality Page

1. On the product control panel, open the Reports menu.

2. Select the Print Quality Page item to print it.

This page contains five bands of color, which are divided into four groups as indicated in the following illustration. By examining each group, you can isolate the problem to a particular print cartridge.

<table>
<thead>
<tr>
<th>Section</th>
<th>Print-cartridge</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Yellow</td>
</tr>
<tr>
<td>2</td>
<td>Cyan</td>
</tr>
<tr>
<td>3</td>
<td>Black</td>
</tr>
<tr>
<td>4</td>
<td>Magenta</td>
</tr>
</tbody>
</table>

- If dots or streaks appear in only one of the groups, replace the print cartridge that correlates with that group.
- If dots appear in more than one group, print a cleaning page. If this does not solve the problem, determine if the dots are always the same color; for example, if magenta dots appear in all five color bands. If the dots are all the same color, replace that print cartridge.
- If streaks appear in multiple color bands, contact HP. A component other than the print cartridge is probably causing the problem.

Inspect the print cartridge for damage

1. Remove the print cartridge from the product, and verify that the sealing tape has been removed.

2. Check the memory chip for damage.
3. Examine the surface of the green imaging drum on the bottom of the print cartridge.

⚠️ CAUTION: Do not touch the green roller (imaging drum) on the bottom of the cartridge. Fingerprints on the imaging drum can cause print-quality problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the print cartridge.

5. If the imaging drum does not appear to be damaged, rock the print cartridge gently several times and reinstall it. Print a few pages to see if the problem has resolved.

**Repeating defects**

If defects repeat at any of the following intervals on the page, a print cartridge might be damaged.

- 22 mm
- 27 mm
- 28 mm
- 75 mm

**Use the printer driver that best meets your printing needs**

You might need to use a different printer driver if the printed page has unexpected lines in graphics, missing text, missing graphics, incorrect formatting, or substituted fonts.
**HP PCL 6 driver**
- Provided as the default driver. This driver is automatically installed unless you select a different one.
- Recommended for all Windows environments
- Provides the overall best speed, print quality, and product-feature support for most users
- Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in Windows environments
- Might not be fully compatible with third-party and custom software programs that are based on PCL 5

**HP UPD PS driver**
- Recommended for printing with Adobe® software programs or with other highly graphics-intensive software programs
- Provides support for printing from postscript emulation needs, or for postscript flash font support

**HP UPD PCL 5**
- Recommended for general office printing in Windows environments
- Compatible with previous PCL versions and older HP LaserJet products
- The best choice for printing from third-party or custom software programs
- The best choice when operating with mixed environments, which require the product to be set to PCL 5 (UNIX, Linux, mainframe)
- Designed for use in corporate Windows environments to provide a single driver for use with multiple printer models
- Preferred when printing to multiple printer models from a mobile Windows computer

**HP UPD PCL 6**
- Recommended for printing in all Windows environments
- Provides the overall best speed, print quality, and printer feature support for most users
- Developed to align with Windows Graphic Device Interface (GDI) for best speed in Windows environments
- May not be fully compatible with third-party and custom solutions based on PCL5

The product does not print or it prints slowly

The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.
   - If the control panel does not indicate the product is ready, turn the product off and then on again.
   - If the control panel indicates the product is ready, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the job again.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check the following items:
   - Check the light next to the network connection on the product. If the network is active, the light is green.
   - Make sure that you are using a network cable and not a phone cord to connect to the network.
   - Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic printer drivers can cause delays clearing jobs from the print queue.

5. From the list of printers on your computer, right-click the name of this product, click Properties, and open the Ports tab.
   - If you are using a network cable to connect to the network, make sure the printer name listed on the Ports tab matches the product name on the product configuration page.
   - If you are using a USB cable and are connecting to a wireless network, make sure the box is checked next to Virtual printer port for USB.

6. If you are using a personal firewall system on the computer, it might be blocking communication with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

7. If your computer or the product is connected to a wireless network, low signal quality or interference might be delaying print jobs.
The product prints slowly

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of specifications, go to this Web site: www.hp.com/support/LJColorM351 or www.hp.com/support/LJColorM451.

2. When you configure the product to print on some paper types, such as heavy paper, the product prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not correct for the type of paper you are using, change the setting to the correct paper type.

3. If your computer or the product is connected to a wireless network, low signal quality or interference might be delaying print jobs.
Solve product connectivity problems

Solve direct-connect problems

If you have connected the product directly to a computer, check the cable.

- Verify that the cable is connected to the computer and to the product.
- Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.
- Verify that the cable is working correctly by connecting it to another product. Replace the cable if necessary.

Solve network problems

Check the following items to verify that the product is communicating with the network. Before beginning, print a configuration page from the product control panel and locate the product IP address that is listed on this page.

- Poor physical connection
- The computer is using the incorrect IP address for the product
- The computer is unable to communicate with the product
- The product is using incorrect link and duplex settings for the network
- New software programs might be causing compatibility problems
- The computer or workstation might be set up incorrectly
- The product is disabled, or other network settings are incorrect

Poor physical connection

1. Verify that the product is attached to the correct network port using a cable of the correct length.
2. Verify that cable connections are secure.
3. Look at the network port connection on the back of the product, and verify that the amber activity light and the green link-status light are lit.
4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1. Open the printer properties and click the Ports tab. Verify that the current IP address for the product is selected. The product IP address is listed on the product configuration page.
2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always print to this printer, even if its IP address changes.
3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of the IP address.

4. If the IP address is correct, delete the product and then add it again.

The computer is unable to communicate with the product

1. Test network communication by pinging the network.
   a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and then type cmd.
   b. Type ping followed by the IP address for your product.
   c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network

Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). If you change these settings, you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct printer driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, printer drivers, and the network redirection.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.
Solve wireless network problems

- Wireless connectivity checklist
- The control panel displays the message: The wireless feature on this product has been turned off
- The product does not print after the wireless configuration completes
- The product does not print, and the computer has a third-party firewall installed
- The wireless connection does not work after moving the wireless router or product
- Cannot connect more computers to the wireless product
- The wireless product loses communication when connected to a VPN
- The network does not appear in the wireless networks list
- The wireless network is not functioning

Wireless connectivity checklist

- The product and the wireless router are turned on and have power. Also make sure the wireless radio in the product is turned on.
- The service set identifier (SSID) is correct. Print a configuration page to determine the SSID. If you are not sure the SSID is correct, run the wireless setup again.
- With secured networks, make sure the security information is correct. If the security information is incorrect, run the wireless setup again.
- If the wireless network is working correctly, try accessing other computers on the wireless network. If the network has Internet access, try connecting to the Internet over a wireless connection.
- The encryption method (AES or TKIP) is the same for the product as it is for the wireless access point (on networks using WPA security).
- The product is within the range of the wireless network. For most networks, the product must be within 30 m (100 ft) of the wireless access point (wireless router).
- Obstacles do not block the wireless signal. Remove any large metal objects between the access point and the product. Make sure poles, walls, or support columns containing metal or concrete do not separate the product and wireless access point.
- The product is located away from electronic devices that might interfere with the wireless signal. Many devices can interfere with the wireless signal including motors, cordless phones, security system cameras, other wireless networks, and some Bluetooth devices.
- The printer driver is installed on the computer.
- You have selected the correct printer port.
- The computer and product connect to the same wireless network.
The control panel displays the message: The wireless feature on this product has been turned off

▲ Press the wireless button on the product to open the Wireless menu, and then turn the wireless radio on.

The product does not print after the wireless configuration completes

1. Make sure the product is turned on and in the ready state.
2. Make sure you are connecting to the correct wireless network.
3. Make sure that the wireless network is working correctly.
   a. Open the **Network configuration** menu, and then open the **Wireless Menu** item.
   b. Select the **Network Test** item to test the wireless network. The product prints a report with the results.
4. Make sure that the correct port or product is selected.
   a. From the list of printers on your computer, right-click the name of this product, click **Properties**, and then open the **Ports** tab.
   b. Make sure the box is checked next to **Virtual printer port for USB**.
5. Make sure that your computer is working correctly. If necessary, restart your computer.

The product does not print, and the computer has a third-party firewall installed

1. Update the firewall with the most recent update available from the manufacturer.
2. If programs request firewall access when you install the product or try to print, make sure you allow the programs to run.
3. Temporarily turn off the firewall, and then install the wireless product on the computer. Enable the firewall when you have completed the wireless installation.

The wireless connection does not work after moving the wireless router or product

Make sure that the router or product connects to the same network that your computer connects to.

1. Open the **Reports** menu, and select the **Configuration Report** item to print the report.
2. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer configuration for your computer.
3. If the SSIDs are not the same, the devices are not connecting to the same network. Reconfigure the wireless setup for your product.
Cannot connect more computers to the wireless product

1. Make sure that the other computers are within the wireless range and that no obstacles block the signal. For most networks, the wireless range is within 30 m (100 ft) of the wireless access point.

2. Make sure the product is turned on and in the ready state.

3. Turn off any third-party firewalls on your computer.

4. Make sure that the wireless network is working correctly.
   a. On the product control panel, open the **Network configuration** menu, and then open the **Wireless Menu** item.
   b. Select the **Network Test** item to test the wireless network. The product prints a report with the results.

5. Make sure that the correct port or product is selected.
   a. From the list of printers on your computer, right-click the name of this product, click **Properties**, and then open the **Ports** tab.
   b. Click the **Configure Port** button to verify that the IP address matches the IP address listed on the Run Network Test report.

6. Make sure that your computer is working correctly. If necessary, restart your computer.

The wireless product loses communication when connected to a VPN

- Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list

- Make sure the wireless router is turned on and has power.
- The network might be hidden. However, you can still connect to a hidden network.
The wireless network is not functioning

1. To verify if the network has lost communication, try connecting other devices to the network.

2. Test network communication by pinging the network.
   a. Open a command-line prompt on your computer. For Windows, click **Start**, click **Run**, and then type `cmd`.
   b. Type `ping` followed by the service set identifier (SSID) for your network.
   c. If the window displays round-trip times, the network is working.

3. Make sure that the router or product connects to the same network that your computer connects to.
   a. Open the **Reports** menu, and select the **Configuration Report** item to print the report.
   b. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer configuration for your computer.
   c. If the SSIDs are not the same, the devices are not connecting to the same network. Reconfigure the wireless setup for your product.
### Solve product software problems with Windows

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>A printer driver for the product is not visible in the <strong>Printer</strong> folder</td>
<td>Reinstall the product software. <strong>NOTE:</strong> Close any applications that are running. To close an application that has an icon in the system tray, right-click the icon, and select <strong>Close</strong> or <strong>Disable</strong>.</td>
</tr>
<tr>
<td>An error message was displayed during the software installation</td>
<td>Reinstall the product software. <strong>NOTE:</strong> Close any applications that are running. To close an application that has an icon in the task bar, right-click the icon, and select <strong>Close</strong> or <strong>Disable</strong>.</td>
</tr>
<tr>
<td>Check the amount of free space on the drive where you are installing the product software. If necessary, free up as much space as you can, and reinstall the product software.</td>
<td>If necessary, run the Disk Defragmenter, and reinstall the product software.</td>
</tr>
<tr>
<td>The product is in Ready mode, but nothing prints</td>
<td>Print a Configuration page, and verify the product functionality.</td>
</tr>
<tr>
<td>Verify that all of the cables are correctly seated and within specifications. This includes the USB and power cables. Try a new cable.</td>
<td>Verify the IP Address on the Configuration Page matches the IP address for the software port. Use one of the following procedures:</td>
</tr>
</tbody>
</table>
2. Click **Settings**.  
3. Click **Printers and Faxes** (using the default Start menu view) or click **Printers** (using the Classic Start menu view).  
4. Right-click the product driver icon, and then select **Properties**.  
5. Click the **Ports** tab, and then click **Configure Port**.  
6. Verify the IP address, and then click **OK** or **Cancel**.  
7. If the IP Addresses are not the same, delete the driver, and reinstall the driver using the correct IP address. |
| Windows 7                                                               | 1. Click **Start**.  
2. Click **Devices and Printers**.  
3. Right-click the product driver icon, and then select **Printer properties**.  
4. Click the **Ports** tab, and then click **Configure Port**.  
5. Verify the IP address, and then click **OK** or **Cancel**.  
6. If the IP Addresses are not the same, delete the driver, and reinstall the driver using the correct IP address. |
Solve product software problems with Mac

- The printer driver is not listed in the Print & Fax list
- The product name does not appear in the product list in the Print & Fax list
- The printer driver does not automatically set up the selected product in the Print & Fax list
- A print job was not sent to the product that you wanted
- When connected with a USB cable, the product does not appear in the Print & Fax list after the driver is selected.
- You are using a generic printer driver when using a USB connection

The printer driver is not listed in the Print & Fax list

1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/PPDs/Contents/Resources. If necessary, reinstall the software.
2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the software.

The product name does not appear in the product list in the Print & Fax list

1. Make sure that the cables are connected correctly and the product is on.
2. Print a configuration page to check the product name. Verify that the name on the configuration page matches the product name in the Print & Fax list.
3. Replace the USB or network cable with a high-quality cable.

The printer driver does not automatically set up the selected product in the Print & Fax list

1. Make sure that the cables are connected correctly and the product is on.
2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/PPDs/Contents/Resources. If necessary, reinstall the software.
3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the software.
4. Replace the USB or network cable with a high-quality cable.
A print job was not sent to the product that you wanted

1. Open the print queue and restart the print job.
2. Another product with the same or similar name might have received your print job. Print a configuration page to check the product name. Verify that the name on the configuration page matches the product name in the Print & Fax list.

When connected with a USB cable, the product does not appear in the Print & Fax list after the driver is selected.

Software troubleshooting

▲ Make sure that your Mac operating system is Mac OS X 10.5 or later.

Hardware troubleshooting

1. Make sure that the product is turned on.
2. Make sure that the USB cable is connected correctly.
3. Make sure that you are using the appropriate high-speed USB cable.
4. Make sure that you do not have too many USB devices drawing power from the chain. Disconnect all of the devices from the chain, and connect the cable directly to the USB port on the computer.
5. Check to see if more than two non-powered USB hubs are connected in a row on the chain. Disconnect all of the devices from the chain, and then connect the cable directly to the USB port on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic printer driver when using a USB connection

If you connected the USB cable before you installed the software, you might be using a generic printer driver instead of the driver for this product.

1. Delete the generic printer driver.
2. Reinstall the software from the product CD. Do not connect the USB cable until the software installation program prompts you.
3. If multiple printers are installed, make sure that you have selected the correct printer in the Format For drop-down menu in the Print dialog box.
A Supplies and accessories

- Order parts, accessories, and supplies
- Part numbers
## Order parts, accessories, and supplies

<table>
<thead>
<tr>
<th>Order supplies and paper</th>
<th><a href="http://www.hp.com/go/suresupply">www.hp.com/go/suresupply</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Order genuine HP parts or accessories</td>
<td><a href="http://www.hp.com/buy/parts">www.hp.com/buy/parts</a></td>
</tr>
<tr>
<td>Order through service or support providers</td>
<td>Contact an HP-authorized service or support provider.</td>
</tr>
</tbody>
</table>

## Part numbers

<table>
<thead>
<tr>
<th>Item</th>
<th>Part number</th>
<th>Cartridge number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print cartridges</td>
<td>CE410A</td>
<td>305A</td>
<td>Standard-capacity black print cartridge with HP ColorSphere toner</td>
</tr>
<tr>
<td></td>
<td>CE410X</td>
<td>305X</td>
<td>High-capacity black print cartridge with HP ColorSphere toner</td>
</tr>
<tr>
<td></td>
<td>CE411A</td>
<td>305A</td>
<td>Cyan print cartridge with HP ColorSphere toner</td>
</tr>
<tr>
<td></td>
<td>CE412A</td>
<td>305A</td>
<td>Yellow print cartridge with HP ColorSphere toner</td>
</tr>
<tr>
<td></td>
<td>CE413A</td>
<td>305A</td>
<td>Magenta print cartridge with HP ColorSphere toner</td>
</tr>
<tr>
<td>Memory</td>
<td>CB423A</td>
<td></td>
<td>256 MB memory DIMM</td>
</tr>
<tr>
<td>Paper-handling accessories</td>
<td>CF106A</td>
<td></td>
<td>250-sheet paper feeder (optional Tray 3)</td>
</tr>
<tr>
<td>USB cable</td>
<td>8121-0868</td>
<td></td>
<td>2-meter A-to-B cable</td>
</tr>
</tbody>
</table>

---

**NOTE:** For information about the yield for the cartridges, see [www.hp.com/go/pageyield](http://www.hp.com/go/pageyield). Actual yield depends on specific use.
B Service and support

- Hewlett-Packard limited warranty statement
- HP's Premium Protection Warranty: LaserJet print cartridge limited warranty statement
- Data stored on the print cartridge
- End User License Agreement
- OpenSSL
- Customer support
- Repack the product
Hewlett-Packard limited warranty statement

<table>
<thead>
<tr>
<th>HP PRODUCT</th>
<th>DURATION OF LIMITED WARRANTY</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP LaserJet 300 color M351a and HP LaserJet 400 color M451nw, M451dn, and M451dw</td>
<td>One-year product exchange</td>
</tr>
</tbody>
</table>

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects in materials and workmanship after the date of purchase, for the period specified above. If HP receives notice of such defects during the warranty period, HP will, at its option, either repair or replace products which prove to be defective. Replacement products may be either new or equivalent in performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date of purchase, for the period specified above, due to defects in material and workmanship when properly installed and used. If HP receives notice of such defects during the warranty period, HP will replace software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable, within a reasonable time, to repair or replace any product to a condition as warranted, you will be entitled to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration, (b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse, (d) operation outside of the published environmental specifications for the product, or (e) improper site preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE. Some countries/regions, states or provinces do not allow limitations on the duration of an implied warranty, so the above limitation or exclusion might not apply to you. This warranty gives you specific legal rights and you might also have other rights that vary from country/region to country/region, state to state, or province to province.

HP’s limited warranty is valid in any country/region or locality where HP has a support presence for this product and where HP has marketed this product. The level of warranty service you receive may vary according to local standards. HP will not alter form, fit or function of the product to make it operate in a country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or provinces do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to you.
THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
HP's Premium Protection Warranty: LaserJet print cartridge limited warranty statement

This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or tampered with in any way, (b) experience problems resulting from misuse, improper storage, or operation outside of the published environmental specifications for the printer product or (c) exhibit wear from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description of the problem and print samples) or contact HP customer support. At HP's option, HP will either replace products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
Data stored on the print cartridge

The HP print cartridges used with this product contain a memory chip that assists in the operation of the product.

In addition, this memory chip collects a limited set of information about the usage of the product, which might include the following: the date when the print cartridge was first installed, the date when the print cartridge was last used, the number of pages printed using the print cartridge, the page coverage, the printing modes used, any printing errors that might have occurred, and the product model. This information helps HP design future products to meet our customers' printing needs.

The data collected from the print cartridge memory chip does not contain information that can be used to identify a customer or user of the print cartridge or their product. However, a customer can choose not to store usage data on the memory chip through the control panel.

HP collects a sampling of the memory chips from print cartridges returned to HP's free return and recycling program (HP Planet Partners: www.hp.com/recycle). The memory chips from this sampling are read and studied in order to improve future HP products. HP partners who assist in recycling this print cartridge might have access to this data, as well.

Any third party possessing the print cartridge might have access to the anonymous information on the memory chip.
End User License Agreement

PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User License Agreement (“EULA”) is a contract between (a) you (either an individual or the entity you represent) and (b) Hewlett-Packard Company (“HP”) that governs your use of the software product (“Software”). This EULA does not apply if there is a separate license agreement between you and HP or its suppliers for the Software, including a license agreement in online documentation. The term “Software” may include (i) associated media, (ii) a user guide and other printed materials, and (iii) “online” or electronic documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO ALL TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING, OR OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU DO NOT ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE SOFTWARE. IF YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA, PLEASE RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN DAYS FOR A REFUND OF THE PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR MADE AVAILABLE WITH ANOTHER HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software (“HP Software”), software under licenses from third parties (“Third Party Software” and “Third Party License”). Any Third Party Software is licensed to you subject to the terms and conditions of the corresponding Third Party License. Generally, the Third Party License is in a file such as “license.txt” or a “readme” file. You should contact HP support if you cannot find a Third Party License. If the Third Party Licenses include licenses that provide for the availability of source code (such as the GNU General Public License) and the corresponding source code is not included with the Software, then check the product support pages of HP's website (hp.com) to learn how to obtain such source code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and conditions of this EULA:

   a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing, copying, storing, loading, executing, displaying, or otherwise using the HP Software. You may not modify the HP Software or disable any licensing or control feature of the HP Software. If this Software is provided by HP for Use with an imaging or printing product (for example, if the Software is a printer driver, firmware, or add-on), the HP Software may only be used with such product (“HP Product”). Additional restrictions on Use may appear in the User Documentation. You may not separate component parts of the HP Software for Use. You do not have the right to distribute the HP Software.

   b. Copying. Your right to copy means you may make archival or back-up copies of the HP Software, provided each copy contains all the original HP Software’s proprietary notices and is used only for back-up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement (collectively “Upgrade”), you must first be licensed for the original HP Software identified by HP as eligible for the Upgrade. To the extent the Upgrade supersedes the original HP Software, you may no longer use such HP Software. This EULA applies to each Upgrade unless HP provides other terms with the Upgrade. In case of a conflict between this EULA and such other terms, the other terms will prevail.
4. TRANSFER.
   a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer of the HP Software to another end user. Any transfer will include all component parts, media, User Documentation, this EULA, and if applicable, the Certificate of Authenticity. The transfer may not be an indirect transfer, such as a consignment. Prior to the transfer, the end user receiving the transferred Software will agree to this EULA. Upon transfer of the HP Software, your license is automatically terminated.
   b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for commercial timesharing or bureau use. You may not sublicense, assign or otherwise transfer the HP Software except as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation are owned by HP or its suppliers and are protected by law, including applicable copyright, trade secret, patent, and trademark laws. You will not remove any product identification, copyright notice, or proprietary restriction from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or disassemble the HP Software, except and only to the extent that the right to do so is allowed under applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information you provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of support services related to the Software or the HP Product. All such information will be subject to HP’s privacy policy. HP will not use such information in a form that personally identifies you except to the extent necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability of HP and its suppliers under this EULA and your exclusive remedy under this EULA will be limited to the greater of the amount actually paid by you for the Product or U.S. $5.00. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FOR LOST PROFITS, LOST DATA, BUSINESS INTERRUPTION, PERSONAL INJURY, OR LOSS OF PRIVACY) RELATED IN ANY WAY TO THE USE OF OR INABILITY TO USE THE SOFTWARE, EVEN IF HP OR ANY SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND EVEN IF THE ABOVE REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some states or other jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. Software was developed entirely at private expense. All Software is commercial computer software within the meaning of the applicable acquisition regulations. Accordingly, pursuant to US FAR 48 CFR 12.212 and DFAR 48 CFR 227.7202, use, duplication and disclosure of the Software by or for the U.S. Government or a U.S. Government subcontractor is subject solely to the terms and conditions set forth in this End User License Agreement, except for provisions which are contrary to applicable mandatory federal laws.
10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i) applicable to the export or import of the Software, or (ii) restricting the Use of the Software, including any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to you in this EULA.

© 2009 Hewlett-Packard Development Company, L.P.

Rev. 04/09
This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written by Tim Hudson (tjh@cryptsoft.com).
# Customer support

<table>
<thead>
<tr>
<th>Service Type</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get telephone support for your country/region</td>
<td>Have the product name, serial number, date of purchase, and problem description ready. Country/region phone numbers are on the flyer that was in the box with your product or at <a href="http://www.hp.com/support/">www.hp.com/support/</a>.</td>
</tr>
<tr>
<td>Get 24-hour Internet support</td>
<td><a href="http://www.hp.com/support/LJColorM351">www.hp.com/support/LJColorM351</a> or <a href="http://www.hp.com/support/LJColorM451">www.hp.com/support/LJColorM451</a></td>
</tr>
<tr>
<td>Get support for products used with a Macintosh computer</td>
<td><a href="http://www.hp.com/go/macosx">www.hp.com/go/macosx</a></td>
</tr>
<tr>
<td>Order additional HP service or maintenance agreements</td>
<td><a href="http://www.hp.com/go/carepack">www.hp.com/go/carepack</a></td>
</tr>
<tr>
<td>Register your product</td>
<td><a href="http://www.register.hp.com">www.register.hp.com</a></td>
</tr>
</tbody>
</table>
Repack the product

If HP Customer Care determines that your product needs to be returned to HP for repair, follow these steps to repack the product before shipping it.

⚠️ **CAUTION:** Shipping damage as a result of inadequate packing is the customer’s responsibility.

1. Remove and retain the print cartridges.

   ⚠️ **CAUTION:** It is *extremely important* to remove the print cartridges before shipping the product. A print cartridge that remains in the product during shipping can leak and cover the product engine and other parts with toner.

   To prevent damage to the print cartridges, avoid touching the rollers on them, and store the print cartridges so that they are not exposed to light.

2. Remove and retain the power cable, interface cable, and any optional accessories.

3. If possible, include print samples and 50 to 100 sheets of paper that did not print correctly.

4. In the U.S., call HP Customer Care to request new packing material. In other areas, use the original packing material, if possible.
C  Product specifications

- Physical specifications
- Power consumption, electrical specifications, and acoustic emissions
- Environmental specifications
Physical specifications

<table>
<thead>
<tr>
<th>Product</th>
<th>Height</th>
<th>Depth</th>
<th>Width</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-duplexing model</td>
<td>322 mm (12.7 inches)</td>
<td>454 mm (17.9 inches)</td>
<td>405 mm (15.9 inches)</td>
<td>22.70 kg (50.0 lb)</td>
</tr>
<tr>
<td>Duplexing model</td>
<td>322 mm (12.7 inches)</td>
<td>484 mm (19.1 inches)</td>
<td>405 mm (15.9 inches)</td>
<td>23.9 kg (52.7 lb)</td>
</tr>
</tbody>
</table>

Power consumption, electrical specifications, and acoustic emissions


⚠️ CAUTION: Power requirements are based on the country/region where the product is sold. Do not convert operating voltages. This will damage the product and void the product warranty.

Environmental specifications

<table>
<thead>
<tr>
<th>Environment</th>
<th>Recommended</th>
<th>Allowed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>17° to 25°C (62.6° to 77°F)</td>
<td>15° to 30°C (59° to 86°F)</td>
</tr>
<tr>
<td>Humidity</td>
<td>30% to 70% relative humidity (RH)</td>
<td>10% to 80% RH</td>
</tr>
<tr>
<td>Altitude</td>
<td>Not applicable</td>
<td>0 to 3048 m (0 to 10,000 ft)</td>
</tr>
</tbody>
</table>
D Regulatory information

- FCC regulations
- Environmental product stewardship program
- Declaration of conformity
- Declaration of conformity (wireless models)
- Safety statements
- Additional statements for wireless products
FCC regulations

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy. If this equipment is not installed and used in accordance with the instructions, it may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase separation between equipment and receiver.
- Connect equipment to an outlet on a circuit different from that to which the receiver is located.
- Consult your dealer or an experienced radio/TV technician.

**NOTE:** Any changes or modifications to the printer that are not expressly approved by HP could void the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.
Environmental product stewardship program

Protecting the environment

Hewlett-Packard Company is committed to providing quality products in an environmentally sound manner. This product has been designed with several attributes to minimize impacts on our environment.

Ozone production

This product generates no appreciable ozone gas (O₃).

Power consumption

Power usage drops significantly while in Ready or Sleep mode, which saves natural resources and saves money without affecting the high performance of this product. Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S. Environmental Protection Agency's ENERGY STAR specifications for imaging equipment. The following mark will appear on ENERGY STAR qualified imaging products:

![Energy Star Logo]

Additional ENERGY STAR qualified imaging product model information is listed at:

[www.hp.com/go/energystar](http://www.hp.com/go/energystar)

Toner consumption

EconoMode uses less toner, which might extend the life of the print cartridge. HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might outlast the mechanical parts in the print cartridge. If print quality begins to degrade and is no longer acceptable, consider replacing the print cartridge.

Paper use

This product’s manual/automatic duplex feature (two-sided printing) and N-up printing (multiple pages printed on one page) capability can reduce paper usage and the resulting demands on natural resources.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to identify plastics for recycling purposes at the end of the product’s life.
HP LaserJet print supplies

It’s easy to return and recycle your HP LaserJet print cartridges after use—free of charge—with HP Planet Partners. Multilingual program information and instructions are included in every new HP LaserJet print cartridge and supplies package. You help reduce the toll on the environment further when you return multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally sound, from product design and manufacturing to distribution, customer use and recycling. When you participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled properly, processing them to recover plastics and metals for new products and diverting millions of tons of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be returned to you. Thank you for being environmentally responsible!

**NOTE:** Use the return label to return original HP LaserJet print cartridges only. Please do not use this label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty returns. For information about recycling your HP inkjet cartridges please go to [http://www.hp.com/recycle](http://www.hp.com/recycle).

Return and recycling instructions

**United States and Puerto Rico**

The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more HP LaserJet print cartridges after use. Please follow the applicable instructions below.

**Multiple returns (more than one cartridge)**

1. Package each HP LaserJet print cartridge in its original box and bag.
2. Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg (70 lb).
3. Use a single pre-paid shipping label.

**OR**

1. Use your own suitable box, or request a free bulk collection box from [www.hp.com/recycle](http://www.hp.com/recycle) or 1-800-340-2445 (holds up to 31 kg (70 lb) of HP LaserJet print cartridges).
2. Use a single pre-paid shipping label.

**Single returns**

1. Package the HP LaserJet print cartridge in its original bag and box.
2. Place the shipping label on the front of the box.

**Shipping**

For US and Puerto Rico HP LaserJet print cartridge recycling returns, use the pre-paid, pre-addressed shipping label contained in the box. To use the UPS label, give the package to the UPS
driver during your next delivery or pick-up, or take it to an authorized UPS drop-off center. (Requested UPS Ground pickup will be charged normal pick-up rates) For the location of your local UPS drop-off center, call 1-800-PICKUPS or visit www.ups.com.

If you are returning the package with the FedEx label, give the package to either the U.S. Postal Service carrier or FedEx driver during your next pick-up or delivery. (Requested FedEx Ground pickup will be charged normal pick-up rates). Or, you can drop off your packaged print cartridge(s) at any U.S. Post Office or any FedEx shipping center or store. For the location of your nearest U.S. Post Office, please call 1-800-ASK-USPS or visit www.usps.com. For the location of your nearest FedEx shipping center/store, please call 1-800-GOFEDEX or visit www.fedex.com.

For more information, or to order additional labels or boxes for bulk returns, visit www.hp.com/recycle or call 1-800-340-2445. Information subject to change without notice.

Residents of Alaska and Hawaii

Do not use the UPS label. Call 1-800-340-2445 for information and instructions. The U.S. Postal Service provides no-cost cartridge return transportation services under an arrangement with HP for Alaska and Hawaii.

Non-U.S. returns

To participate in HP Planet Partners return and recycling program, just follow the simple directions in the recycling guide (found inside the packaging of your new product supply item) or visit www.hp.com/recycle. Select your country/region for information on how to return your HP LaserJet printing supplies.

Paper

This product is capable of using recycled papers when the paper meets the guidelines outlined in the HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper according to EN12281:2002.

Material restrictions

This HP product does not contain added mercury.

This HP product does not contain a battery.
Disposal of waste equipment by users in private households in the European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with your other household waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help to conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city office, your household waste disposal service or the shop where you purchased the product.

Chemical substances

HP is committed to providing our customers with information about the chemical substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/reach.

Material Safety Data Sheet (MSDS)

Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner) can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/community/environment/productinfo/safety.
For more information

To obtain information about these environmental topics:

- Product environmental profile sheet for this and many related HP products
- HP’s commitment to the environment
- HP’s environmental management system
- HP’s end-of-life product return and recycling program
- Material Safety Data Sheets

Declaration of conformity

Hewlett-Packard Company

11311 Chinden Boulevard
Boise, Idaho 83714-1021, USA

HP LaserJet Pro 300 color M351a
HP LaserJet Pro 400 color M451dn
BOISB-1002-00
ALL
CE410A, CE410X, CE411A, CE412A, CE413A

SAFETY:
IEC 60950-1:2005 / EN60950-1: 2006 +A11
IEC 60825-1:2007 / EN 60825-1:2007 (Class 1 Laser/LED Product)
GB4943-2001

EMC:
EN 61000-3-2:2006
EN 61000-3-3:2008
EN 55024:1998 +A1 +A2
FCC Title 47 CFR, Part 15 Class B¹ / ICES-003, Issue 4
GB9254-2008, GB17625.1-2003

ENERGY USE:
Regulation (EC) No. 1275/2008
ENERGY STAR® Qualified Imaging Equipment Typical Electricity Consumption (TEC) Test Procedure

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. For regulatory purposes, these products are assigned a Regulatory model number. This number should not be confused with the product name or the product number(s).

Boise, Idaho USA

October 2011

For Regulatory Topics only, contact:

European Contact         Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-TRE / Standards Europe, Herrenberger Straße 140, D-71034, Böblingen (FAX: +49-7031-14-3143)
                         www.hp.eu/certificates

USA Contact              Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho 83707-0015 (Phone: 208-396-6000)
Declaration of conformity (wireless models)

Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: Hewlett-Packard Company  
Manufacturer's Address:  
11311 Chinden Boulevard  
Boise, Idaho 83714-1021, USA

declares, that the product  
Product Name:  
HP LaserJet Pro 400 color M451nw  
HP LaserJet Pro 400 color M451dw

Regulatory Model:  
2) BOISB-1002-01

Product Options:  
ALL

Radio Module:  
3) SDGOB-0892

Print Cartridges:  
CE410A, CE410X, CE411A, CE412A, CE413A

conforms to the following Product Specifications:

SAFETY:  
IEC 60950-1:2005 / EN60950-1:2006 +A11  
IEC 60825-1:2007 / EN 60825-1:2007 (Class 1 Laser/LED Product)  
GB4943-2001

EMC:  
EN 61000-3-2:2006  
EN 61000-3-3:2008  
EN 55024:1998 +A1 +A2  
FCC Title 47 CFR, Part 15 Class B¹) / ICES-003, Issue 4  
GB9254-2008, GB17625.1-2003

Radio³)  
EN 301 489-1 v1.8.1 (2008-04) / EN 301 489-17 v2.1.1 (2009-05)  
EN 300 328 v1.7.1 (2006-10)  
FCC Title 47 CFR, Part 15 Subpart C (Section 15.247) / IC: RSS-210

ENERGY USE:  
Regulation (EC) No. 1275/2008  
ENERGY STAR® Qualified Imaging Equipment Typical Electricity Consumption (TEC) Test Procedure

Supplementary Information:  

208 Appendix D  Regulatory information ENWW
This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. For regulatory purposes, these products are assigned a Regulatory model number. This number should not be confused with the product name or the product number(s).

3. This product uses a radio module device which Regulatory Model number is SDGOB-0892 as needed to meet technical regulatory requirements for the countries/regions this product will be sold.

Boise, Idaho USA

October 2011

For Regulatory Topics only, contact:

European Contact Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-TRE / Standards Europe, Herrenberger Straße 140, D-71034, Böblingen (FAX: +49-7031-14-3143) www.hp.eu/certificates

USA Contact Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho 83707-0015 (Phone: 208-396-6000)
Safety statements

Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has implemented regulations for laser products manufactured since August 1, 1976. Compliance is mandatory for products marketed in the United States. The device is certified as a “Class 1” laser product under the U.S. Department of Health and Human Services (DHHS) Radiation Performance Standard according to the Radiation Control for Health and Safety Act of 1968. Since radiation emitted inside the device is completely confined within protective housings and external covers, the laser beam cannot escape during any phase of normal user operation.

⚠️ **WARNING!** Using controls, making adjustments, or performing procedures other than those specified in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations

Complies with Canadian EMC Class B requirements.

« Conforme à la classe B des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)

この装置は、クラスB情報技術装置です。この装置は、家庭環境で使用することを目的としていますが、この装置がラジオやテレビジョン受信機に近接して使用されると、受信障害を引き起こすことがあります。取扱説明書に従って正しい取り扱いをして下さい。

VCCI-B

Power cord instructions

Make sure your power source is adequate for the product voltage rating. The voltage rating is on the product label. The product uses either 100-127 Vac or 220-240 Vac and 50/60 Hz.

Connect the power cord between the product and a grounded AC outlet.

⚠️ **CAUTION:** To prevent damage to the product, use only the power cord that is provided with the product.

Power cord statement (Japan)

製品には、同梱された電源コードをお使い下さい。
同梱された電源コードは、他の製品では使用出来ません。
EMC statement (Korea)

| B급 기기  | 이 기기는 가정용(B급)으로 전자파적합등록을 한 기기로서 주로 가정에서 사용하는 것을 목적으로 하며, 모든 지역에서 사용할 수 있습니다. |

Laser statement for Finland

Luokan 1 laserlaite

Klass 1 Laser Apparat


VAROITUS !

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.

WARNING !

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för osynlig laserstrålning, som överskrider gränsen för laserklass 1.

HUOLTO

HP LaserJet 300 color M351a, HP LaserJet 400 color M451nw, M451dn, M451dw - kirjoittimen sisällä ei ole käyttäjän huolloitavissa olevia kohteita. Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu henkilö. Tällaiseksi huoltotoimenpiteeksi ei katsota värinaikakasän vaihtamista, paperiradan puhdistusta tai muita käyttäjän käsikirjassa lueteltuja, käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan suorittaa ilman erikoistyökaluja.

VARO !

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömälle lasersäteilylle laitteen ollessa toiminnassa. Älä katso sateeseen.

WARNING !

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig laserstrålning. Betrakta ej strålen.

Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista: Aallonpituus 775-795 nm Teho 5 m W Luokan 3B laser.
GS statement (Germany)

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert werden.

Substances Table (China)

有毒有害物质表
根据中国电子信息产品污染控制管理办法的要求而出台

<table>
<thead>
<tr>
<th>部件名称</th>
<th>铅 (Pb)</th>
<th>汞 (Hg)</th>
<th>镉 (Cd)</th>
<th>六价铬 (CrVI)</th>
<th>多溴联苯 (PBB)</th>
<th>多溴二苯醚 (PBDE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>打印引擎</td>
<td>X</td>
<td>0</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>控制面板</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>塑料外壳</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>格式化板组件</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>碳粉盒</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

0：表示在此部件所用的所有同类材料中，所含的此有毒或有害物质均低于SJ/T11363-2006的限制要求。
X：表示在此部件所用的所有同类材料中，至少一种所含的此有毒或有害物质高于SJ/T11363-2006的限制要求。

注：引用的“环保使用期限”是根据在正常温度和湿度条件下操作使用产品而确定的。

Restriction on Hazardous Substances statement (Turkey)

Türkiye Cumhuriyeti: EEE Yönetmeliğine Uyumdu

Restriction on Hazardous Substances statement (Ukraine)

Обладання відповідає вимогам Технічного регламенту щодо обмеження використання деяких небезпечних речовин в електричному та електронному обладнанні, затвердженого постановою Кабінету Міністрів України від 3 грудня 2008 № 1057
Additional statements for wireless products

FCC compliance statement—United States

Exposure to radio frequency radiation

⚠️ CAUTION: The radiated output power of this device is far below the FCC radio frequency exposure limits. Nevertheless, the device shall be used in such a manner that the potential for human contact during normal operation is minimized.

In order to avoid the possibility of exceeding the FCC radio frequency exposure limits, human proximity to the antenna shall not be less than 20 cm (8 in) during normal operation.

This device complies with Part 15 of FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

⚠️ CAUTION: Based on Section 15.21 of the FCC rules, changes of modifications to the operation of this product without the express approval by Hewlett-Packard Company may invalidate its authorized use.

Australia statement

This device incorporates a radio-transmitting (wireless) device. For protection against radio transmission exposure, it is recommended that this device be operated no less than 20 cm from the head, neck, or body.

Brazil ANATEL statement

Este equipamento opera em caráter secundário, isto é, não tem direito à proteção contra interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência a sistemas operando em caráter primário.

Canadian statements

For Indoor Use. This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the radio interference regulations of the Canadian Department of Communications. The internal wireless radio complies with RSS 210 of Industry Canada.

Pour l’usage d’intérieur. Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de Classe B prescribes dans le règlement sur le brouillage radioélectrique édicté par le Ministère des Communications du Canada. Le composant RF interne est conforme à la norme CNR-210 d’Industrie Canada.

European Union regulatory notice

The telecommunications functionality of this product may be used in the following EU and EFTA countries/regions:
Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden, Switzerland, and United Kingdom.

Notice for use in France

For 2.4 GHz Wireless LAN operation of this product certain restrictions apply: This equipment may be used indoor for the entire 2400-2483.5 MHz frequency band (channels 1-13). For outdoor use, only 2400-2454 MHz frequency band (channels 1-9) may be used. For the latest requirements, see www.arcep.fr.

L'utilisation de cet équipement (2.4 GHz Wireless LAN) est soumise à certaines restrictions : Cet équipement peut être utilisé à l'intérieur d'un bâtiment en utilisant toutes les fréquences de 2400-2483.5 MHz (Chaine 1-13). Pour une utilisation en environnement extérieur, vous devez utiliser les fréquences comprises entre 2400-2454 MHz (Chaine 1-9). Pour les dernières restrictions, voir, www.arcep.fr.

Notice for use in Russia

Существуют определенные ограничения по использованию беспроводных сетей (стандарта 802.11 b/g) с рабочей частотой 2,4 ГГц: Данное оборудование может использоваться внутри помещений с использованием диапазона частот 2400-2483,5 МГц (каналы 1-13). При использовании внутри помещений максимальная эффективная изотропно-излучаемая мощность (ЭИИМ) должна составлять не более 100мВт.

Korean statement

당해 무선설비는 운용 중 전파혼선 가능성이 있음
Taiwan statement

低功率電波輻射性電機管理辦法

第十二條 經型式認證合格之低功率射頻電機，非經許可，公司、商號或使用者均不得擅自變更頻率、加大功率或變更原設計之特性及功能。

第十四條 低功率射頻電機之使用不得影響飛航安全及干擾合法通信；經發現有干擾現象時，應立即停用，並改善至無干擾時方得繼續使用。前項合法通信，指依電信法規定作業之無線電通信。低功率射頻電機須忍受合法通信或工業、科學及醫療用電波輻射性電機設備之干擾。

Vietnam Telecom wired/wireless marking for ICTQC Type approved products

![Vietnam Telecom marking]

ENWW Additional statements for wireless products 215
accessories ordering 183, 184
acoustic specifications 198
AirPrint 33, 38
anticounterfeit supplies 68
archive setting 17
automatic crossover, setting 18

batteries included 203
bin, output jams, clearing 160
legal extension 5
locating 5
booklets creating (Windows) 111

calibrating color 12
Canadian DOC regulations 210
canceling print job 86
cartridge-door release, locating 5
cartridges non-HP 67
recycling 67, 202
replacing 69
storage 67
supplies status page 10, 122
warranty 188
cautions iii
color adjusting 116

calibrating 12
Edge Control 118
halftone options 118
matching 120
Neutral Grays 118
printed vs. monitor 120
printing in grayscale (Windows) 102
color alignment, calibrating 166
color options
HP EasyColor (Windows) 119
setting (Windows) 100
color settings adjusting 164
Color tab settings 37
color usage log 10, 122
configuration page 10, 122
configuring IP address 29
connecting to a wireless network 46
connectivity solving problems 173
USB 43
contrast display, control panel 13
custom print settings (Windows) 88
curl, paper settings 17
customer support online 194
repacking product 195
courier font settings 16
cover pages
printing (Mac) 35
printing on different paper (Windows) 107
customer support disposal, end-of-life 203
defaults, restoring 17
defaults, restoring 139
defects, repeating 76, 169
DIMMs installing 127
verifying installation 131
document conventions iii
double-sided printing (duplexing)
Mac 36
downloading software printing system 19
Macintosh driver settings 34
  custom-size paper 35
  watermarks 35
managing network 49
matching colors 120
material restrictions 203
Material Safety Data Sheet (MSDS) 204
media
  custom-size, Macintosh settings 34
  default settings 12
  first page 35
  pages per sheet 36
memory
  included 2
  installing 127
  part number 184
  permanent resources 131
  verifying installation 131
memory chip, print cartridge description 189
menu
  Quick Forms 11
menus, control panel
  HP Web Jetadmin 124
  models supporting 2
  settings 18
  settings report 10, 122
networks, wired
  installing product 45
Neutral Grays 118
non-HP supplies 67
notebook paper, printing 11
notes iii
obtaining
  IP address 45
  on/off button 5
  online support 194
opening printer drivers (Windows) 87
operating systems supported 20, 28
ordering
  supplies and accessories 184
ordering supplies
  Web sites 183
orientation
  selecting, Windows 98
output bin
  jams, clearing 160
  locating 5
output quality
  archive setting 17
Packing product 195
page count 10, 122
page sizes
  scaling documents to fit (Windows) 109
  pages per minute 2
  pages per sheet 36
  selecting (Windows) 96
paper
  covers, using different paper 107
  curl settings 17
  custom-size, Macintosh settings 34
  default settings 12
default size for tray 62
first and last pages, using different paper 107
first page 35
jams 153
pages per sheet 36
printing on preprinted letterhead or forms (Windows) 102
selecting 165
supported sizes 54
paper jams. See jams
paper path
  jams, clearing 158
paper pickup problems solving 153
paper size
  changing 53
paper sizes
  selecting 92
  selecting custom 92
paper type
  changing 163
paper types
  changing 53
  selecting 93
paper, ordering 184
paper, special
  printing (Windows) 104
PCL drivers 20
  universal 22
PCL font list 10, 122
permanent resources 131
physical specifications 198
portrait orientation
  selecting, Windows 98
ports
  types included 6
power
  consumption 198
  power button 5
  power connection, locating 6
preprinted paper
  printing (Windows) 102
presets (Mac) 34
print cartridges
  checking for damage 75, 168
door release, locating 5
memory chips 189
non-HP 67
part numbers 64, 184
recycling 67, 202
storage 67
supplies status page 10, 122
warranty 188
print cartridges, accessing 5
print job
   canceling 86
print media
   supported 54
print quality
   archive setting 17
   improving 163
   improving (Windows) 92
print quality page
   interpreting 75, 168
   printing 75, 168
print-cartridges
   replacing 69
printer driver
   configuring wireless network 48
printer drivers
   choosing 169
printer drivers (Mac)
   changing settings 31
   settings 34
printer drivers (Windows)
   changing settings 23
   settings 87
   supported 20
printing
   settings (Mac) 34
   settings (Windows) 87
printing on both sides
   settings (Windows) 93
printing system software 19
priority, settings 23, 31
problem-solving
   no response 171
   slow response 172
PS Emulation drivers 20
PS font list 10, 122
Q
quality
   archive setting 17
R
rear door, locating 6
recycling 4, 202
   HP printing supplies returns and environmental program 202
recycling supplies 67
removing Mac software 31
removing Windows software 25
repacking product 195
repeating defects, troubleshooting 76, 169
repetitive defects, troubleshooting 76, 169
reports
   print quality page 10, 122
   Reports menu 10
resize documents
   Macintosh 34
   Windows 109
resource saving 131
restoring default settings 17
restoring factory settings defaults 139
S
safety statements 210, 211
saving resources, memory 131
scale documents
   Macintosh 34
   Windows 109
service
   repacking product 195
   Service menu 17
   service page 10, 122
   settings
      driver presets (Mac) 34
      drivers 23
      drivers (Mac) 31
      factory settings, restoring 139
      network report 10, 122
      priority 23, 31
      restoring defaults 17
      System Setup menu 12
shipping product 195
shortcuts (Windows)
   creating 90
   using 88
size specifications, product 198
sizes, media
   default, setting 12
sleep delay
   disabling 125
   enabling 125
software
   embedded Web server 25
   HP Utility 32
   installing, HP Smart Install 42
   installing, USB connections 43
   installing, wired networks 46
   Linux 26
   problems 179
   settings 23, 31
   software license agreement 190
   Solaris 26
   supported operating systems 20, 28
   uninstalling for Windows 25
   uninstalling Mac 31
   UNIX 26
   Web sites 19
   Windows 26
Solaris software 26
solving
   direct-connect problems 173
   network problems 173
special paper
   printing (Windows) 104
specifications
   electrical and acoustic 198
   physical 198
status
   HP Utility, Mac 32
   supplies, printing report 10, 122
storing
   print cartridges 67
supplies
   counterfeit 68
   non-HP 67
   ordering 183, 184
   recycling 67, 202
   status, viewing with HP Utility 32
   supplies status page 10, 122
   printing 74, 167
support
   online 194
   repacking product 195
supported paper 54
System Setup menu 12

T
TCP/IP
settings 18
technical support
online 194
repacking product 195
tips iii
toner cartridges. See print cartridges
transparencies
printing (Windows) 104
trapping 118
Tray 1
double-sided printing 36
jams, clearing 156
settings 12
tray 1
locating 5
Tray 2
capacity 5
jams, clearing 157
locating 5
settings 12
Tray 3
capacity 5
locating 5
part number 184
trays
default paper size 62
double-sided printing 36
 included 2
jams, clearing 157
locating 5
selecting (Windows) 93
settings 12
troubleshooting
control panel messages 140
direct-connect problems 173
jams 153, 155
Mac problems 180
network problems 173
repeating defects 76, 169
two-sided printing
settings (Windows) 93

U
uninstalling Mac software 31
uninstalling Windows software 25
wireless network connection 46
universal print driver 22
W
warnings iii
warranty
license 190
print cartridges 188
product 186
watermarks 35
adding (Windows) 111
Web printing
HP ePrint 33
Web sites 26
customer support 194
fraud reports 68
HP Web Jetadmin,
downloading 124
Macintosh customer support 194
Material Safety Data Sheet (MSDS) 204
ordering supplies 183
software, downloading 19
universal print driver 22
Windows
driver settings 23
drivers supported 20
software components 26
supported operating systems 20
universal print driver 22
wireless button
locating 5
wireless network
configuring with USB 30, 47
configuring with WPS 30, 47
installing the driver 48